CasaXPS Manual
2.3.15 Introduction to XPS and AES

Neal Fairley
Casa Software Ltd
CasaXPS Manual 2.3.15

CasaXPS Processing Software

Casa Software Ltd.

NO WARRANTY

Casa Software Ltd. does its best to ensure the accuracy and reliability of the Software and Related Documentation. Nevertheless, the Software and Related Documentation may contain errors that may affect its performance to a greater or lesser degree. Therefore no representation is made nor warranty given that the Software and Related Documentation will be suitable for any particular purpose, or that data or results produced by the Software and Related Documentation will be suitable for use under any specific conditions, or that the Software and Related Documentation will not contain errors. Casa Software Ltd. shall not in any way be liable for any loss consequential, either directly or indirectly, upon the existence of errors in the Software and Related Documentation. The Software and Related Documentation, including instructions for its use, is provided “AS IS” without warranty of any kind. Casa Software Ltd. further disclaims all implied warranties including without limitation any implied warranties of merchantability or fitness for a particular purpose. CasaXPS should not be relied on for solving a problem whose incorrect solution could result in injury to a person or loss of property. The entire risk arising out of the use or performance of the Software and Related Documentation remains with the Recipient. In no event shall Casa Software Ltd. be liable for any damages whatsoever, including without limitation, damages for loss of business profit, business interruption, loss of business information or other pecuniary loss, arising out of the use or inability to use the Software or written material, even if Casa Software Ltd. has been advised of the possibility of such damages.

Acknowledgements

Casa Software Ltd would like to thank all those providing data and offering enlightening discussions leading to the current state of the CasaXPS software and manual. It is a humbling experience to work with so many knowledgeable people and the author would like to express gratitude to all concerned.
# Contents

CasaXPS Processing Software ............................................................................................................. 2
Casa Software Ltd. ................................................................................................................................. 2
NO WARRANTY .................................................................................................................................... 2
Acknowledgements ............................................................................................................................... 2
XPS Spectra .......................................................................................................................................... 5
  Other Peaks in XPS Spectra ............................................................................................................... 10
Basic Quantification of XPS Spectra .................................................................................................... 11
  How to Compare Samples .................................................................................................................. 13
  Relative Intensity of Peaks in XPS .................................................................................................... 14
  Overlapping Peaks ............................................................................................................................. 15
  Peak Positions .................................................................................................................................. 17
  Charge Compensation ....................................................................................................................... 17
Depth Profiling using XPS ..................................................................................................................... 19
Understanding Relative Sensitivity Factors for Doublet Transitions ..................................................... 22
  Electronic Energy Levels and XPS Peaks ......................................................................................... 27
Basics of CasaXPS ................................................................................................................................ 29
CasaXPS Main Window ......................................................................................................................... 29
Loading Data into CasaXPS .................................................................................................................. 30
Displaying Data in CasaXPS .................................................................................................................. 31
  Selection of Data using the Mouse ..................................................................................................... 33
  Tile Format ....................................................................................................................................... 35
  Tile Display ...................................................................................................................................... 36
  Zooming into Data ............................................................................................................................. 37
Processing Spectra ................................................................................................................................. 40
  Basic Energy Calibration .................................................................................................................... 41
Quantification of Spectra ....................................................................................................................... 43
  Creating Backgrounds and Regions ................................................................................................. 44
  Quantification of Survey Spectrum using Regions .......................................................................... 49
  Creating Peak Models ....................................................................................................................... 56
  Quantification using Standard Reports ............................................................................................ 65
Transferring Regions and Components to other Data .......................................................................... 68
  Copying Data to a New Experiment Frame ...................................................................................... 74
Annotating Spectra ............................................................................................................................... 75
Quantification of AES Data .................................................................................................................. 82
  Differentiation of Spectra .................................................................................................................. 84

3
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Savitzky-Golay Method</td>
<td>84</td>
</tr>
<tr>
<td>Creating Derivative Spectra for Peak-to-Peak Quantification</td>
<td>87</td>
</tr>
<tr>
<td>Converting Direct Spectra to Differentiated Spectra</td>
<td>89</td>
</tr>
<tr>
<td>Quantification Regions for AES data</td>
<td>93</td>
</tr>
<tr>
<td>Creating Quantification Regions using the Element Library</td>
<td>95</td>
</tr>
<tr>
<td>Propagation of Quantification Regions</td>
<td>97</td>
</tr>
<tr>
<td>Quantification Reports</td>
<td>99</td>
</tr>
<tr>
<td>Standard Reports</td>
<td>101</td>
</tr>
<tr>
<td>Custom Reports</td>
<td>107</td>
</tr>
<tr>
<td>CasaXPS Element Library</td>
<td>127</td>
</tr>
<tr>
<td>Element Library Format</td>
<td>127</td>
</tr>
<tr>
<td>Importing a JEOL Element Library</td>
<td>132</td>
</tr>
<tr>
<td>Concentration Calculation</td>
<td>133</td>
</tr>
<tr>
<td>Auger Imaging in CasaXPS</td>
<td>136</td>
</tr>
<tr>
<td>Auger Image Analysis Steps in CasaXPS</td>
<td>139</td>
</tr>
<tr>
<td>Ordering the Images using the Experimental Variable</td>
<td>140</td>
</tr>
<tr>
<td>Copying VAMAS blocks between Experiment Frames</td>
<td>142</td>
</tr>
<tr>
<td>Converting Images to Differentiated Spectra</td>
<td>144</td>
</tr>
<tr>
<td>Quantifying the Spectra at Pixels to Produce Images</td>
<td>148</td>
</tr>
<tr>
<td>RBD Instruments Inc. Auger Scan</td>
<td>151</td>
</tr>
<tr>
<td>Survey Spectra</td>
<td>151</td>
</tr>
<tr>
<td>Multiplex Auger Spectra</td>
<td>157</td>
</tr>
<tr>
<td>Depth Profile Data</td>
<td>158</td>
</tr>
<tr>
<td>Examples of XPS Spectra</td>
<td>166</td>
</tr>
</tbody>
</table>
XPS Spectra

The XPS technique is used to investigate the chemistry at the surface of a sample.

![Schematic of an XPS instrument.](image)

**Figure 1:** Schematic of an XPS instrument.

The basic mechanism behind an XPS instrument is illustrated in Figure 1. Photons of a specific energy are used to excite the electronic states of atoms below the surface of the sample. Electrons ejected from the surface are energy filtered via a hemispherical analyser (HSA) before the intensity for a defined energy is recorded by a detector. Since core level electrons in solid-state atoms are quantized, the resulting energy spectra exhibit resonance peaks characteristic of the electronic structure for atoms at the sample surface. While the x-rays may penetrate deep into the sample, the escape depth of the ejected electrons is limited. That is, for energies around 1400 eV, ejected electrons from depths greater than 10nm have a low probability of leaving the surface without undergoing an energy loss event, and therefore contribute to the background signal rather than well defined primary photoelectric peaks.

In principle, the energies of the photoelectric lines are well defined in terms of the binding energy of the electronic states of atoms. Further, the chemical environment of the atoms at the surface result in well defined energy shifts to the peak energies. In the case of conducting samples, for which the detected electron energies can be referenced to the Fermi energy of the spectrometer, an absolute energy scale can be established, thus aiding the identification of species. However, for non-conducting samples the problem of energy calibration is significant. Electrons leaving the sample surface cause a potential
difference to exist between the sample and the spectrometer resulting in a retarding field acting on the electrons escaping the surface. Without redress, the consequence can be peaks shifted in energy by as much as 150 eV. Charge compensation designed to replace the electrons emitted from the sample is used to reduce the influence of sample charging on insulating materials, but nevertheless identification of chemical state based on peak positions requires careful analysis.

XPS is a quantitative technique in the sense that the number of electrons recorded for a given transition is proportional to the number of atoms at the surface. In practice, however, to produce accurate atomic concentrations from XPS spectra is not straightforward. The precision of the intensities measured using XPS is not in doubt; that is intensities measured from similar samples are repeatable to good precision. What may be doubtful are results reporting to be atomic concentrations for the elements at the surface. An accuracy of 10% is typically quoted for routinely performed XPS atomic concentrations. For specific carefully performed and characterised measurements better accuracy is possible, but for quantification based on standard relative sensitivity factors, precision is achieved not accuracy. Since many problems involve monitoring changes in samples, the precision of XPS makes the technique very powerful.

The first issue involved with quantifying XPS spectra is identifying those electrons belonging to a given transition. The standard approach is to define an approximation to the background signal. The background in XPS is non-trivial in nature and results from all those electrons with initial energy greater than the measurement energy for which scattering events cause energy losses prior to emission from the sample. The zero-loss electrons constituting the photoelectric peak are considered to be the signal above the background approximation. A variety of background algorithms are used to measure the peak area; none of the practical algorithms are correct and therefore represent a source for uncertainty when computing the peak area. Peak areas computed from the background subtracted data form the basis for most elemental quantification results from XPS.
Figure 2: An example of a typical XPS survey spectrum taken from a compound sample.

The data in Figure 2 illustrates an XPS spectrum measured from a typical sample encountered in practice. The inset tile within Figure 2 shows the range of energies associated with the C 1s and K 2p photoelectric lines. Since these two transitions include multiple overlapping peaks, there is a need to apportion the electrons to the C 1s or the K 2p transitions using a synthetic peak model fitted to the data. The degree of correlation between the peaks in the model influences the precision and therefore the accuracy of the peak area computation.

Relative sensitivity factors of photoelectric peaks are often tabulated and used routinely to scale the measured intensities as part of the atomic concentration calculation. These RSF tables can only be accurate for homogenous materials. If the sample varies in composition with depth, then the kinetic energy of the photoelectric line alters the depth from which electrons are sampled. It is not uncommon to see evidence of an element in the sample by considering a transition at high kinetic energy, but find little evidence for the presence of the same element when a lower kinetic energy transition is considered. Transitions of this nature might be Fe 2p compared to Fe 3p both visible in Figure 2, where the relative intensity of these peaks will depend on the depth of the iron with respect to the surface. Sample roughness and angle of the sample to the
analyser also changes the relative intensity of in-homogenous samples, thus sample preparation and mounting can influence quantification values.

The chemical shifts seen in XPS data are a valuable source of information about the sample. The spectra in Figure 3 and Figure 4 illustrate the separation of elemental and oxide peaks of germanium due to chemical state. Both spectra were acquired from the same sample under the same conditions with the exception that the ejected electrons for the Ge 3d peaks are about 1200
eV more energetic than the Ge 2p electrons. The consequence of choosing to quantify based on one of these transitions is that the proportion of oxide to elemental germanium differs significantly. The oxide represents an over layer covering of the elemental germanium and therefore the low energy photoelectrons from the Ge 2p line are attenuated resulting in a shallower sampling depth compared to the more energetic Ge 3d electrons. Hence the volume sampled by the Ge 2p transition favours the oxide signal, while the greater depth from which Ge 3d electrons can emerge without energy loss favours the elemental germanium. While these variations may seem a problem, such changes in the spectra are also a source for information about the sample.

Tilting the sample with respect to the axis of the analyser results in changing the sampling depth for a given transition and therefore data collected at different angles vary due to the differing composition with depth. Figure 5 is a sequence of Si 2p spectra measured from the same silicon sample at different angles. The angles associated with the spectra are with respect to the axis of the analyser and the sample surface. Data measured at 30° favours the top most oxide layers; while at 90° the elemental substrate becomes dominant in the spectrum.

![Figure 5: Angle resolved Si 2p spectra showing the changes to the spectra resulting from tilting the sample with respect to the analyser axis.](image)
Other Peaks in XPS Spectra

Not all peaks in XPS data are due to the ejection of an electron by a direct interaction with the incident photon. The most notable are the Auger peaks, which are explained in terms of the decay of a more energetic electron to fill the vacant hole created by the x-ray photon, combined with the emission of an electron with an energy characteristic of the difference between the states involved in the process. The spectrum in Figure 2 includes a sequence of peaks labelled O KLL. These peaks represent the energy of the electrons ejected from the atoms due to the filling of the O 1s state (K shell) by an electron from the L shell coupled with the ejection of an electron from an L shell.

Unlike the photoelectric peaks, the kinetic energy of the Auger lines is independent of the photon energy for the x-ray source. Since the kinetic energy of the photoelectrons are given in terms of: the photon energy $h\nu$, the binding energy for the ejected electron $E_{ke}$ and a work function $\phi$ by the relationship $E_{ke} = h\nu - E_{ke} - \phi$, altering the photon energy by changing the x-ray anode material causes the Auger lines and the photoelectric lines to move in energy relative to one another.

Figure 6: Elemental Silicon loss peaks and also x-ray satellite peak.
Less prominent than Auger lines are x-ray satellite peaks. Data acquired using a non-monochromatic x-ray source create satellite peaks offset from the primary spectral lines by the difference in energy between the resonances in the x-ray spectrum of the anode material used in the x-ray gun and also in proportion to the peaks in the x-ray spectrum for the anode material. Figure 6 indicates an example of a satellite peak to the primary Si 2p peak due to the use of a magnesium anode in the x-ray source. Note that Auger line energies are independent of the photon energy and therefore do not have satellite peaks.

A further source for peaks in the background signal is due to resonant scattering of electrons by the surface materials. Plasmon peaks for elemental silicon are also labelled on Figure 6. The sharpness of these plasmon peaks in Figure 6 is due to the nature of the material through which the photoelectrons must pass. For silicon dioxide, the loss structures are much broader and follow the trend of a typical XPS background signal. The sharp loss structures in Figure 6 are characteristic of pure metallic-like materials.

![Figure 6: Satellite peak example](image)

Figure 6: Satellite peak example

### Basic Quantification of XPS Spectra

XPS counts electrons ejected from a sample surface when irradiated by x-rays. A spectrum representing the number of electrons recorded at a sequence of energies includes both a contribution from a background signal and also resonance peaks characteristic of the bound states of the electrons in the
surface atoms. The resonance peaks above the background are the significant features in an XPS spectrum shown in Figure 7.

XPS spectra are, for the most part, quantified in terms of peak intensities and peak positions. The peak intensities measure how much of a material is at the surface, while the peak positions indicate the elemental and chemical composition. Other values, such as the full width at half maximum (FWHM) are useful indicators of chemical state changes and physical influences. That is, broadening of a peak may indicate: a change in the number of chemical bonds contributing to a peak shape, a change in the sample condition (x-ray damage) and/or differential charging of the surface (localised differences in the charge-state of the surface).

![Figure 8: Quantification regions](image)

The underlying assumption when quantifying XPS spectra is that the number of electrons recorded is proportional to the number of atoms in a given state. The basic tool for measuring the number of electrons recorded for an atomic state is the quantification region. Figure 8 illustrates a survey spectrum where the surface is characterised using a quantification table based upon values computed from regions. The primary objectives of the quantification region are to define the range of energies over which the signal can be attributed to
the transition of interest and to specify the type of approximation appropriate for the removal of background signal not belonging to the peak.

Figure 9: O 1s Region

How to Compare Samples

A direct comparison of peak areas is not a recommended means of comparing samples for the following reasons. An XPS spectrum is a combination of the number of electrons leaving the sample surface and the ability of the instrumentation to record these electrons; not all the electrons emitted from the sample are recorded by the instrument. Further, the efficiency with which emitted electrons are recorded depends on the kinetic energy of the electrons, which in turn depends on the operating mode of the instrument. As a result, the best way to compare XPS intensities is via, so called, percentage atomic concentrations. The key feature of these percentage atomic concentrations is the representation of the intensities as a percentage, that is, the ratio of the intensity to the total intensity of electrons in the measurement. Should the experimental conditions change in any way between measurements, for example the x-ray gun power output, then peak intensities would change in an absolute sense, but all else being equal, would remain constant in relative terms.
Relative Intensity of Peaks in XPS

Each element has a range of electronic states open to excitation by the x-rays. For an element such as silicon, both the Si 2s and Si 2p transitions are of suitable intensity for use in quantification. The rule for selecting a transition is to choose the transition for a given element for which the peak area, and therefore in principle the RSF, is the largest, subject to the peak being free from other interfering peaks.

Transitions from different electronic states from the same element vary in peak area. Therefore, the peak areas calculated from the data must be scaled to ensure the same quantity of silicon, say, is determined from either the Si 2s or the Si 2p transitions. More generally, the peak areas for transitions from different elements must be scaled too. A set of relative sensitivity factors are necessary for transitions within an element and also for all elements, where the sensitivity factors are designed to scale the measured areas so that meaningful atomic concentrations can be obtained, regardless of the peak chosen.

Quantification of the spectrum in Figure 8 requires the selection of one transition per element. Figure 9 illustrates the area targeted by the region defined for the O 1s transition; similar regions are defined for the C 1s, N 1s and Si 2p transitions leading to the quantification table displayed over the data in Figure 8. The Regions property page shown in Figure 10 provides the basic

Figure 10: Regions Property Page.
mechanism for creating and updating the region parameters influencing the computed peak area. Relative sensitivity factors are also entered on the Regions property page. The computed intensities are adjusted for instrument transmission and escape depth corrections, resulting in the displayed quantification table in Figure 8.

Quantification regions are useful for isolated peaks. Unfortunately not all samples will offer clearly resolved peaks. A typical example of interfering peaks is any material containing both aluminium and copper. When using the standard magnesium or aluminium x-ray anodes, the only aluminium photoelectric peaks available for measuring the amount of aluminium in the sample are Al 2s and Al 2p. Both aluminium peaks appear at almost the same binding energy as the Cu 3s and Cu 3p transitions. Thus estimating the intensity of the aluminium in a sample containing these elements requires a means of modelling the data envelope resulting from the overlapping transitions illustrated in Figure 11.

![Figure 11: Aluminium and Copper both in evidence at the surface.](image)

**Overlapping Peaks**

Techniques for modelling data envelopes not only apply to separating elemental information, such as the copper and aluminium intensities in Figure 11, but also apply to chemical state information about the aluminium itself. Intensities for the aluminium oxide and metallic states in Figure 11 are measured using synthetic line-shapes or components. An XPS spectrum
typically includes multiple transitions for each element; while useful to identify the composition of the sample, the abundance of transitions frequently leads to interference between peaks and therefore introduces the need to construct peak models. Figure 12 illustrates a spectrum where a thin layer of silver on silicon (University of Iowa, Jukna, Baltrusaitis and Virzonis, 2007, unpublished work) introduces an interference with the Si 2p transition from the Ag 4s transition.

![Figure 12: Elemental and oxide states of Silicon](image)

The subject of peak-fitting data is complex. A model is typically created from a set of Gaussian/Lorentzian line-shapes. Without careful model construction involving additional parameter constraints, the resulting fit, regardless of how accurate a representation of the data, may be of no significance from a physical perspective. The subject of peak fitting XPS spectra is dealt with in detail elsewhere.

Peak models are created using the Components property page on the Quantification Parameters dialog window shown in Figure 13. A range of line-shapes are available for constructing the peak models including both symmetric and asymmetric functional forms. The intensities modelled using these synthetic line-shapes are scaled using RSFs and quantification using both components and regions are offered on the Report Spec property page of CasaXPS.
Peak Positions

In principle, the peak positions in terms of binding energy provide information about the chemical state for a material. The data in Figure 2 provides evidence for at least three chemical states of silicon. Possible candidates for these silicon states might be SiO$_2$, Si$_2$O$_3$, SiO, Si$_2$O or Si, however an assignment based purely on the measured binding energies for the synthetic line-shapes relies on an accurate calibration for the energy scale. Further, the ability to calibrate the energy scale is dependent on the success of the charge compensation for the sample and the availability of a peak at known binding energy to provide a reference for shifting the energy scale.

Figure 13: Components property page on the Quantification Parameters dialog window.

Charge Compensation

The XPS technique relies on electrons leaving the sample. Unless these emitted electrons are replaced, the sample will charge relative to the instrument causing a retarding electric field at the sample surface. For conducting samples electrically connected to the instrument, the charge balance is easily restored; however, for insulating materials electrons must be replaced via an external source. Insulating samples are normally electrically isolated from the instrument and low energy electrons and/or ions are introduced at the sample surface. The objective is to replace the photoelectrons to provide a steady state electrical environment from which the energy of the photoelectrons can be measured.
Figure 14: Insulating sample before and after charge compensation.

The data in Figure 14 shows spectra from PTFE (Teflon) acquired with and without charge compensation. The C 1s peaks are shifted by 162 eV between the two acquisition conditions, but even more importantly, the separation between the C 1s and the F 1s peaks differ between the two spectra by 5 eV. Without effective charge compensation, the measured energy for a photoelectric line may change as a function of kinetic energy of the electrons.

Charge compensation does not necessarily mean neutralization of the sample surface. The objective is to stabilize the sample surface to ensure the best peak shape, whilst also ensuring peak separation between transitions is independent of the energy at which the electrons are measured. Achieving a correct binding energy for a known transition is not necessarily the best indicator of good charge compensation. A properly charge compensated experiment typically requires shifting in binding energy using the Calibration property page, but the peak shapes are good and the relative peak positions are stable.

A nominally conducting material may need to be treated as an insulating sample. Oxide layers on metallic materials can transform a conducting material
into an insulated surface. For example, aluminium metal oxidizes even in vacuum and a thin oxide layer behaves as an insulator.

Calibrating spectra in CasaXPS is performed using the Calibration property page on the Spectrum Processing dialog window.

**Depth Profiling using XPS**

![Figure 15: Segment of an XPS depth profile.](image)

While XPS is a surface sensitive technique, a depth profile of the sample in terms of XPS quantities can be obtained by combining a sequence of ion gun etch cycles interleaved with XPS measurements from the current surface. An ion gun is used to etch the material for a period of time before being turned off whilst XPS spectra are acquired. Each ion gun etch cycle exposes a new surface and the XPS spectra provide the means of analysing the composition of these surfaces.

![Figure 16: The set of O 1s spectra measured during a depth profiling experiment.](image)
The set of XPS spectra corresponding to the oxygen 1s peaks from a depth profile experiment depicted logically in Figure 15 are displayed in Figure 16. The objective of these experiments is to plot the trend in the quantification values as a function of etch-time.

The actual depth for each XPS analysis is dependent on the etch-rate of the ion-gun, which in turn depends on the material being etched at any given depth. For example, the data in Figure 16 derives from a multilayer sample consisting of silicon oxide alternating with titanium oxide layers on top of a silicon substrate. The rate at which the material is removed by the ion gun may vary between the layers containing silicon oxide and those layers containing titanium oxide, with a further possible variation in etch-rate once the silicon substrate is encountered. The depth scale is therefore dependent on characterizing the ion-gun however each XPS measurement is typical of any other XPS measurement, with the understanding that the charge compensation steady state may change between layers.

![Graph of XPS Depth Profile](image)

Figure 17: XPS Depth Profile of silicon oxide/titanium oxide multilayer sample profiled using a Kratos Amicus XPS instrument.
The XPS depth profile in Figure 17 is computed from the VAMAS file data logically ordered in CasaXPS as shown in Figure 18. The O 1s spectra displayed in Figure 16 are highlighted in Figure 18. One point to notice about the profile in Figure 17 is that the atomic concentration calculation for the O 1s trace is relatively flat for the silicon oxide and titanium oxide layers, in contrast to the raw data in Figure 16, where the chemically shifted O 1s peaks would appear to be more intense for the silicon oxide layers compared to the titanium oxide layers. This observation is supported by the plot of adjusted peak areas in Figure 19, where again the O 1s trace is far from flat. The profile in Figure 17 is far more physically meaningful than the variations displayed in Figure 19. Normalization of the XPS intensities to the total signal measured on a layer by layer basis is important for understanding the sample. This example is a good illustration of why XPS spectra should be viewed in the context of the other elements measured from a surface.

The details of how to analyze a depth profile in CasaXPS are discussed at length in The Casa Cookbook and other manual pages available from the Help option on the Help menu.
Figure 19: Peak areas scaled by RSF used to compute the atomic concentration plots in Figure 17.

Understanding Relative Sensitivity Factors for Doublet Transitions

When quantifying XPS spectra, Relative Sensitivity Factors (RSF) are used to scale the measured peak areas so variations in the peak areas are representative of the amount of material in the sample surface. An element library typically contains lists of RSFs for XPS transitions. For some transitions more than one peak appears in the data in the form of doublet pairs and, in the case of the default CasaXPS library, three entries are available for each set of doublet peaks: one entry for the combined use of both doublet peaks in a quantification table and two entries for situations where only one of the two possible peaks are used in the quantification. A common cause of erroneous quantification is the inappropriate use of these optional RSF entries.
The data in Figure 20 are a set of high resolution spectra where quantification regions and components are used to calculate the area for the peaks. These data illustrate some of the issues associated with XPS quantification as the data includes singlet peaks in the form of O 1s, C 1s, Al 2s and N 1s; as well as doublet pairs: Cr 2p, Cu 2p, Ar 2p and Fe 2p. The spectra are sufficiently complex to involve overlaps such as the Al 2s and Cu 3s, while the Cu 2p\(^{1/2}\) peak includes signal from a Cr Auger line. When creating a table of percentage atomic concentrations it is important to select the correct RSF for the peak area chosen to measure the given element.

<table>
<thead>
<tr>
<th>Name</th>
<th>R.S.F.</th>
<th>% Conc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cr 2p 1/2</td>
<td>10.6041</td>
<td>2.9</td>
</tr>
<tr>
<td>Cr 2p 3/2</td>
<td>10.6041</td>
<td>6.2</td>
</tr>
<tr>
<td>Fe 2p 1/2</td>
<td>14.8912</td>
<td>2.2</td>
</tr>
<tr>
<td>Fe 2p 3/2</td>
<td>14.8912</td>
<td>4.5</td>
</tr>
<tr>
<td>Cu 2p 3/2</td>
<td>15.0634</td>
<td>4.4</td>
</tr>
<tr>
<td>Al 2s Metal</td>
<td>0.753</td>
<td>61.4</td>
</tr>
<tr>
<td>Al 2s Ox</td>
<td>0.753</td>
<td>5.1</td>
</tr>
<tr>
<td>Ar 2p</td>
<td>2.65797</td>
<td>5.5</td>
</tr>
<tr>
<td>O 1s</td>
<td>2.93</td>
<td>6.2</td>
</tr>
<tr>
<td>C1s</td>
<td>1</td>
<td>1.5</td>
</tr>
<tr>
<td>N1s</td>
<td>1.8</td>
<td>0.2</td>
</tr>
</tbody>
</table>

Table 1: Quantification table showing RSFs used to scale the raw peak areas.

When measuring a transition, from the perspective of signal to noise, it is better to include both peaks from a doublet pair. For the data in Figure 20, the Fe 2p, Cr 2p and Ar 2p transitions are free of interference from other peaks and therefore simple integration regions can be used to measure the peak areas. The Ar 2p doublet peaks overlap each other; however the Cr 2p and Fe 2p peaks do not overlap, thus separate quantification regions are used to
measure the area for these resolved doublet peaks. Even though separate regions are used to estimate the peak areas for the two peaks in each of the Cr 2p and the Fe 2p transitions, total RSFs for these transitions are used to scale the raw area calculated from the regions. Similarly, the total RSF is used to scale the Ar 2p doublet peaks, because both peaks from the doublet are used in calculating the peak area for argon. On the other hand, since the Cu 2p₁/₂ peak overlaps with the Cr LMM Auger transition, only the Cu 2p₃/₂ peak can be used with ease and so the reduced RSF must be applied to scale the peak area. The quantification table in Table 1 lists the regions and components used to calculate the atomic concentrations together with the RSFs for each transition. 

Note the peak model used to measure the Al 2s includes a component representing the contribution of the Cu 3s transition to the Al 2s spectrum in Figure 20. Copper is measured using the Cu 2p₃/₂ peak therefore the RSF for the Cu 3s component is set to zero so that the component does not appear in Table 1.

By way of example, an alternative quantification regime might be to use only one of the two possible Fe 2p doublet peaks. The quantification in Table 2 removes the Fe 2p₁/₂ region from the calculation by setting the RSF to zero, whilst adjusting the Fe 2p₃/₂ RSF to accommodate the absence of the Fe 2p₁/₂ peak area from the calculation. Since the ratio of 2p doublet peaks should be 2:1, the RSF for the Fe 2p₃/₂ region is two thirds of the total RSF used in Table 1. In Table 1, the percentage atomic concentration for Fe is split between the two Fe 2p doublet peaks, whereas in Table 2 the entire Fe 2p contribution is estimated using the Fe 2p₃/₂ and therefore the same amount of Fe is measured via either approach.

A common misunderstanding is to use both peaks in the calculation, but still assign RSFs for the individual peaks in the doublet. The consequence of using both peaks and the specific RSFs to the individual peaks in the doublet is the contribution from Fe to the quantification table would be incorrectly increased by a factor of two.

Note: the RSFs used in both Table 1 and Table 2 are Scofield cross-sections adjusted for angular distribution corrections for an instrument with angle of 90° between the analyser and x-ray source.
<table>
<thead>
<tr>
<th>Name</th>
<th>R.S.F.</th>
<th>% Conc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cr 2p 1/2</td>
<td>10.6041</td>
<td>2.9</td>
</tr>
<tr>
<td>Cr 2p 3/2</td>
<td>10.6041</td>
<td>6.2</td>
</tr>
<tr>
<td>Fe 2p 3/2</td>
<td>9.8064</td>
<td>6.8</td>
</tr>
<tr>
<td>Cu 2p 3/2</td>
<td>15.0634</td>
<td>4.4</td>
</tr>
<tr>
<td>Al 2s Metal</td>
<td>0.753</td>
<td>61.3</td>
</tr>
<tr>
<td>Al 2s Ox</td>
<td>0.753</td>
<td>5.1</td>
</tr>
<tr>
<td>Ar 2p</td>
<td>2.65797</td>
<td>5.5</td>
</tr>
<tr>
<td>O 1s</td>
<td>2.93</td>
<td>6.2</td>
</tr>
<tr>
<td>C1s</td>
<td>1</td>
<td>1.5</td>
</tr>
<tr>
<td>N1s</td>
<td>1.8</td>
<td>0.2</td>
</tr>
</tbody>
</table>

Table 2: Fe 2p 3/2 peak is used without the area from the Fe 2p1/2.

To further illustrate the issues associated with the uses of the three RSFs associated with doublet peaks, consider the three possible options available when quantifying the Cr 2p doublet shown in Figures 21, 22 and 23. Table 3 shows that the corrected area when measured using any of these three options is approximately the same.

![Figure 21: Intensity for Cr calculated from the Cr 2p1/2 transition.](image)

<table>
<thead>
<tr>
<th>Cr 2p1/2 RSF</th>
<th>Raw Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.60721</td>
<td>19234.8</td>
</tr>
</tbody>
</table>
Figure 22 Intensity for Cr calculated from the Cr 2p$_{3/2}$ transition.

Cr 2p$_{3/2}$ RSF | Raw Area  
---|---
6.9697 | 40871.9

Figure 23 Intensity for Cr calculated from both peaks in the doublet.

Total RSF | Raw Area  
---|---
10.6041 | 60098.5
Table 3: Comparison of the intensities calculated from the three different combinations of peak area and RSF for the Cr 2p doublet illustrated in Figure 21 Figure 22 and Figure 23.

**Electronic Energy Levels and XPS Peaks**

An electron spectrum is essentially obtained by monitoring a signal representing the number of electrons emitted from a sample over a range of kinetic energies. The energy for these electrons, when excited using a given photon energy, depends on the difference between the initial state for the electronic system and the final state. If both initial and final states of the electronic system are well defined, a single peak appears in the spectrum. Well defined electronic states exist for systems in which all the electrons are paired with respect to orbital and spin angular momentum. The initial state for the electronic system offers a common energy level for all transitions. When an electron is emitted from the initial state due to the absorption of a photon, the electrons emerge with kinetic energies characteristic of the final states available to the electronic system and therefore XPS peaks represent the excitation energies open to the final states. Since these final states include electronic sub-shells with unpaired electrons, the spin-orbit coupling of the orbital and spin angular moment results in the splitting of the energy levels otherwise identical in terms of common principal and orbital angular momentum. Thus, instead of a single energy level for a final state, the final state splits into two states referred to in XPS as doublet pairs. To differentiate between these XPS peaks, labels are assigned to the peaks based on the hole in the final state electronic configuration. Since these final states, even when split by spin-orbit interactions, are still degenerate in the sense that more than one electronic state results in the same energy for the system, three quantum numbers are sufficient to identify the final state for the x-ray excited system. Specifying the three quantum numbers in the format nlj both uniquely
identifies the transition responsible for a peak in the spectrum and offers information regarding the degeneracy of the electronic state involved. The relative intensity of these doublet pair peaks linked by the quantum numbers \(nl\) is determined from the \(j = l \pm \frac{1}{2}\) quantum number. Doublet peaks appear with intensities in the ratio \(2j_1 + 1 : 2j_2 + 1\). Thus p-orbital doublet peaks are assigned j quantum numbers \(\frac{1}{2}\) and \(\frac{3}{2}\) and appear with relative intensities in the ratio 1:2.

Similar intensity ratios and differing energy separations are common features of doublet peaks in XPS spectra. Final states with s symmetry do not appear as doublets, e.g. Au 4s.
Basics of CasaXPS

The following is an introduction to the basics of CasaXPS. The intention is to provide an overview of the software in terms of displaying and quantifying XPS spectra.

**CasaXPS Main Window**

The Main Window of CasaXPS is a multiple document interface capable of managing large numbers of files all open at the same time.

Key points:

- Each file opened in CasaXPS appears in an experiment frame.
- The top-most experiment frame has mouse focus.
- An experiment frame is divided into two panes; the left-hand pane displays the data in graphical form, while the right-hand pane displays the logical structure of the VAMAS file opened in CasaXPS.

Management of experiment frames is performed using the Window menu on the CasaXPS main window.

- Experiment frames may appear full sized.
• Experiment frames may be tiled.

• Or as icons within the CasaXPS Main Window.

**Loading Data into CasaXPS**

CasaXPS converts other data formats to ASCII ISO 14976 (VAMAS) format. Data in VAMAS format are opened as experiment frames by selecting the VAMAS file via the Open option on the File menu.
A file dialog window allows data to be selected from disk.

Data not in VAMAS format is converted through CasaXPS via the Convert option on the File menu. A Convert to VAMAS file dialog window offers a means of selecting a file type for conversion. The file extension is typically used to determine the file format, for example, the file extension spe is allocated to data saved in PHI Multipak format.

A new VAMAS file is created for each file selected via the dialog window and is written into the same directory as the original file.

**Displaying Data in CasaXPS**

One or more files may be selected via the file dialog. On pressing the Open button, a new experiment frame appears in the CasaXPS main window.
Initially, the first row of data blocks are selected in the right-hand pane and displayed via a scrolled list of display tiles in the left-hand pane.
The keyboard arrow keys can be used to change the selection in the right-hand pane. Each press of an arrow key moves the selection in the right-hand pane with respect to the data block displayed in the active tile in the left-hand pane. Pressing an arrow key causes the newly selected data block to be displayed in the left-hand pane.

**Selection of Data using the Mouse**

Data blocks in the right-hand pane are selected using the mouse and a combination of the Shift key and the Control key.

Left click the mouse over a data block in the right-hand pane to make a single selection.

Extend the selection to a contiguous group of data blocks by holding the Shift key down before selecting a second data block using the left mouse button.
Add to the current selection by holding the Control key down before left-clicking over a data block.

Overlay the current selection of data blocks in the active tile by pressing the overlay toolbar button.

Display the current selection one-per-tile using the display toolbar button.
Tile Format

Set the number of tiles-per page using the Page Tile Format dialog window.

Page tile formats are organized using predefined property pages for a number of tiles per page. Adjustments to the tile format involve choosing the tile alignment type.

Specifying the number of rows (or columns):

Specifying the number of tiles per row for each row enabled:
Tile Display

Each tile used to display data in the left-hand pane maintains a set of display settings. These display settings are adjusted using the Tile Display Parameter dialog window. Various fonts and colours used to draw spectra are adjusted via the property pages on the dialog window.

The tile in the left-hand pane with the title highlighted is the active tile. On pressing the toolbar button for the Tile Display Parameters dialog window, the settings entered onto the property pages correspond to the display settings for the active tile. When the OK or Apply button is pressed on the dialog window, the display settings for the active tile are updated.
Data displayed in the active tile is indicated in the right-hand pane by a red border around the corresponding data block. The background for the data block in the active tile is also filled with a light yellow colour.

**Zooming into Data**

Changing the energy and intensity ranges for a spectrum is achieved using the mouse to draw a zoom box over the data currently displayed in the active tile. A zoom box is drawn over the data by holding down the left-hand mouse button whilst moving the cursor over the spectrum in the active tile. On releasing the mouse button, the drag box becomes a solid box over the data marking the energy limits and also the intensity limits over which it is desired to view the data.

To perform the zoom action, left-click inside the zoom box or press the zoom in toolbar button on the second toolbar.

Each time a zoom action is performed, the parameters from the zoom box is placed on a zoom list. Following a sequence of zoom actions, the set of zoom
states on the zoom list can be reviewed by pressing the zoom out toolbar button.

Each time the zoom out button is pressed, the previous energy and intensity ranges defined by zoom boxes are reinstated sequentially until the initial display ranges first used to view the data are recovered. Further pressing of the zoom out button will cause the zoom list to cycle from the initial zoom state.

The zoom list is re-initialised by pressing the reset toolbar button:

If the data are prepared with quantification regions, pressing the reset button loads the zoom list with the quantification region limits. To view a set of peaks on a survey spectrum for which regions are defined, simply press the reset button followed by the zoom out button.
Zooming into a zone based on the mouse may require further adjustments to the display to achieve the desired perspective of the data. Further intensity scaling and positioning of the data with respect to the energy axis are achieved using the toolbar buttons:

Adjustments to the energy interval accompanied by rescaling of the intensity with respect to the data within the energy interval are performed using the toolbar buttons on the second toolbar:
Drag zoom box over data of interest.

Zoom in
Or
Left-click inside zoom box.

Step right

Energy interval shifted by half the display width.

Rescaling using the data within the current energy interval is achieved using the toolbar buttons:

**Processing Spectra**

Processing spectra is performed using options on the Spectrum Processing dialog window. The Spectrum processing dialog window is invoked from the Options menu or the top toolbar.
The Processing History property page lists the processing currently contributing to the state of the data displayed in the active tile. Other property pages offer processing options such as charge compensation and data smoothing.

**Basic Energy Calibration**

Shifting the energy scale to allow for sample charging is performed on the Calibration property page:

There are many powerful methods for charge compensating data located in many different files or sets of data within the same file, for example a depth profile. Only the basic charge compensation is described here.

Essentially, charge compensation is performed by specifying the location of a peak in the data as recorded. The measured location of the peak is associated with the desired true location of the peak, from which the necessary shift is
determined. The calculated shift may be applied to one or more spectra as appropriate.

**Charge Compensation for a Set of High Resolution Spectra**

Display the spectrum for which a peak position is known:

Using the mouse, left-click the cursor on the peak as displayed in the active tile. The energy identified by the cursor position is updated in the Measured text-field on the Calibration property page.

Enter the known value for the peak position in the True text-field.

If regions and/or components are defined on any of the VAMAS blocks for which charge compensation will be performed, tick the Region and Component tick boxes.

Select those VAMAS blocks for which the charge compensation shift is appropriately specified by the data in the active tile.

Press the Apply to Selection button.
Each VAMAS block selected in the right-hand pane of the experiment frame will be shifted using the energy difference computed from the Measured and True text-fields on the Calibration property page.

**Quantification of Spectra**

XPS quantification in terms of peak intensities is performed by assigning quantification regions and/or peak models containing synthetic components. Quantification in CasaXPS is performed using the Quantification Parameters dialog window where the Regions, Components and Report Spec property pages are central to preparing and extracting quantification information from the data.
Creating Backgrounds and Regions

Quantification regions are energy intervals over which a background to the peaks is defined.

A region is defined using the Regions property page where each region appears as a column of parameters in a scrolled list.
Each column in the scrolled list is divided into editable parameters and quantities computed for the region defined by the parameters.

To edit a region parameter, left-click the mouse over the value displayed on the table on the Regions property page.

The value modified within the edit text field is only accepted when the enter key is pressed on the keyboard. Before pressing the enter-key, left-clicking the mouse away from the edit field causes the previous value to be reinstated.

Regions are defined in terms of a regions name:

Region names are user-defined names used to reference the information determined from the region. Quantification tables typically include the region name and more importantly quantities calculated from a region are specified within custom reports using the names assigned to a region.
A Relative Sensitivity Factor or RSF for a peak identified by a region is typically extracted from the element library, but may be adjusted using the RSF row.

<table>
<thead>
<tr>
<th>Regions</th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>C1s</td>
<td>N1s</td>
<td>C1s</td>
</tr>
<tr>
<td>RSF</td>
<td>0.891</td>
<td>0.78</td>
<td>0.278</td>
</tr>
<tr>
<td>Start</td>
<td>205.16</td>
<td>542.063</td>
<td>234.361</td>
</tr>
<tr>
<td>End</td>
<td>192.589</td>
<td>527.516</td>
<td>281.697</td>
</tr>
</tbody>
</table>

Atomic concentration tables are computed from the raw peak area divided by the RSF parameter. Other corrections to the raw peak area are also applied when determining the atomic concentration; however the instrumental independent correction used to relate the relative intensity of different photoelectric transitions for an element is encapsulated in the RSF.

The start and end parameters define the energy interval over which a peak should be measured.

<table>
<thead>
<tr>
<th>RSF</th>
<th>0.891</th>
<th>0.78</th>
<th>0.278</th>
<th>1.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>205.16</td>
<td>542.063</td>
<td>234.361</td>
<td>10</td>
</tr>
<tr>
<td>End</td>
<td>192.589</td>
<td>527.516</td>
<td>281.697</td>
<td>10</td>
</tr>
<tr>
<td>BG Type</td>
<td>Linear</td>
<td>Linear</td>
<td>Linear</td>
<td>Liu</td>
</tr>
</tbody>
</table>

These energy limits define the point at which the background meets the recorded data.

A range of background (BG) types are offered, the most commonly used types are linear, Shirley and Tougaard.

<table>
<thead>
<tr>
<th>BG Type</th>
<th>Linear</th>
<th>Linear</th>
<th>Linear</th>
<th>Liu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Linear backgrounds are typically used for insulating materials, while steps in metallic data are modelled using a Shirley background.
The full set of background types can be selected via a dialog window invoked by holding the Control key down and left-clicking over the current BG-type setting before the parameter is an edit field.

A new background is selected from the list on the dialog window and is loaded into the BG type text field when the OK button is pressed. To accept the selection of the background type, press the enter key on the keyboard.

The BG type field may be typed into the edit-field as an abbreviation. The most commonly used BG types are entered using “l” for linear, “s” for Shirley and “t” for Tougaard.
The background and spectrum meet at the two energy limits to the region. Due to noise in the data, the actual data channel corresponding to the region limits may not be most appropriate for defining the background intensity at these limits. The Av Width parameter specifies the number of data channels on either side of the data channel corresponding to the start energy or the end energy over which an average intensity is determined for the background at the limits.

When using the Av Width parameter there must be sufficient data channels to either side of both start and end limits before the background intensity is determined using an averaged intensity. The largest source for precision errors in XPS measurements is due to poorly defined background intensities. The use of an appropriate Av width for the level of noise in the data is important.

Two additional parameters influence the intensity of the background at the region limits. The start offset and end offset provide a means of scaling the background intensity at the region limits. The value specified for these parameters represents a percentage drop from the initial intensity computed for the background intensity.
The cross section and tag fields are for advanced uses and therefore are not discussed here.

**Quantification of Survey Spectrum using Regions**

The best route to creating quantification regions is via the Element Library dialog window. The advantage of using the element library lies in the direct link between specifying the peaks and the RSF scaling information from the library. The simplest route to creating quantification regions is via the Find Peak/Create Regions buttons on the element table property page.

Regions are created via the Create Regions button for all those features on a spectrum for which:

1. An element marker from the element library is active.
2. A feature within the data can be identified.
3. The RSF is the largest or the transition is explicitly selected for use via the CasaXPS_quant.lib configuration file.

Using the element library dialog window, the first step is therefore to enable element markers for all the appropriate species within the data. The manual route to enabling element markers involves the element table, the left-hand pane and the mouse. With the Element Table property page top-most on the Element Library dialog window, left-click the mouse with the cursor pointing at a peak in the data. The element table scrolls to display those transitions with energies around the energy indicated by the mouse. Select the most likely transition from the table on the Element Table using the name field.
Element markers are placed on the data for all transitions in the element table from the indicated element. The process is repeated for each peak in the data until all peaks are assigned to element markers.
Regions are created based on the proximity of element markers to the peaks in the data. In the event the energy scale needs calibrating, the calibration step should be performed before attempting to create regions.

To calibrate the energy scale for an individual spectrum:

Select the Spectrum processing dialog window

Select the Calibration property page

Left click the cursor pointing at the peak maximum of an appropriate peak in the left-hand pane and enter the True energy for the indicated peak.
Press the Apply button to calibrate the spectrum in the active tile.

Provided the peaks are within a tolerance of the element markers and the peaks of interest are accounted for by the element markers, pressing the Create Regions button on the Element Table property page will create a set of regions on the spectrum.

An annotation table offering a quantification table is added to the spectrum.
The element markers used to identify and link the peaks to transitions in the element library may be removed from the display by pressing the Clear All Elements button on the Element Table property page.

The quantification table may be repositioned on the data using the Annotation History property page.

With the Annotation History property page top-most on the Annotation dialog window, a small box appears above the top left-hand corner of the annotation table.

\[
\begin{array}{c|c|c|c}
\text{Name} & \text{Pos.} & \text{Fwhm} & \text{Area} & \text{At\%} \\
\hline
\text{Na 1s} & 1070.3133 & 2.2661 & 90087.392 & 32.87 \\
\text{Cl 2p} & 197.6116 & 3.1368 & 10129.201 & 25.81 \\
\text{C 1s} & 283.8301 & 3.6796 & 7193.521 & 22.23 \\
\end{array}
\]

Pointing at the centre of the small box then dragging the mouse causes the annotation to move to a new position the moment the mouse button is released. Other adjustments to the intensity scale for display purposes can be made using toolbar buttons.
It is also advisable to check the quantification regions created automatically on the data. The zoom options described above provide a means of systematically stepping through the current list of quantification regions. If the Regions property page on the Quantification Parameters dialog window is top-most, stepping through the set of regions using the zoom options allows the limits for the regions to be visually inspected and adjusted under mouse control.

Adjusting the limits for a region under mouse control involves using the mouse to drag a limit to a new position. Region limits can be adjusted under mouse control only when the Region property page is top-most on the Quantification Parameters dialog window. A grey vertical zone indicates that the mouse is active with respect to adjusting the region end points.

Following an adjustment to the limits, the annotation table and Regions property page are updated with the start and/or end energies defined by the cursor.
Manual Creation of Regions

Regions created based on element markers require an identifiable peak to exist. If no such feature is located near the element markers no region is created for the element in question. Under these circumstances manual creation of regions is appropriate. While a Create button is available on the Regions property page of the Quantification Parameters dialog window, peaks from a survey spectrum have no means of assignment to transitions; therefore the Element Table property page includes a feature for manually creating regions specified via the name field in the element table.

To create regions one at a time:

1. Invoke the Quantification Parameters dialog window and ensure the Regions property page is top most
2. Tick the box on the Element Library dialog window on the Element Table property page labelled Create When Line Selected.
3. In the active tile, zoom the display to the energy interval about the transition for which a region is required.
4. Left click the name field on the Element Table appropriate for the transition.
Adjust the start and end limits using the mouse or otherwise position the region appropriately for the transition selected.

**Creating Peak Models**

Constructing a peak model requires the definition of a background using the Regions property page and the introduction of synthetic component peaks via the Components property page.

The Regions property page is used to define a background to the data envelope.
The intensity from a quantification region can be explicitly excluded from a quantification report by entering an RSF of zero.
The function of the region is to define the background only allowing the intensities from the synthetic components to estimate the sample composition.

Components are created using the Element Table property page in an analogous way to the method for creating individual regions. Left-click the mouse with the cursor over a peak as displayed in the left-hand pane. The Element Table scrolled list changes to display those transitions around the energy indicated by the cursor.

Tick the box on the Element Table property page labelled Create When Line Selected. With the Components property page top-most on the Quantification Parameters dialog window, left-click the appropriate name field within the element table for the transition identified in the left-hand pane.

A peak is added to the display and the Component property page is updated.
New peaks are added to the data where the residual is the greatest. The new peak is therefore unlikely to appear in the correct position with respect to the peak envelope. Using the mouse, point at the peak maximum for the newly created peak and drag the cursor to the appropriate position for the synthetic component.

Repeat the process for each peak believed to be part of the model.
The example involves two elements and potentially five chemical states: one chemical state for the potassium and four for the carbon data. The two potassium peaks are part of a double pair; therefore the RSF for the combined pair of peaks is used when quantification is performed.

While it would be possible at this stage in the peak modelling process to press the Fit Component button on the Component property page, the number of peaks and level of noise in the data suggests that constraints will be required to achieve a valid physical description based on non-linear least squares peak fitting.

A peak model is defined in terms of a name field and RSF serving exactly the same function as the name and RSF fields for regions. Fields specific to components are the line-shape parameter and the three parameters for area, position and full width at half maximum (FWHM) of the synthetic component. The parameters determined in a least squares sense are the area, position and FWHM. Constraints are available for restricting the possible values for these parameters during optimisation.
Constraints take two forms:

1. Parameter intervals offering a range of acceptable values for each parameter adjusted during a least squares optimisation.

2. Relational constraints between parameters from different components.

An interval is specified as a pair of numerical values separated by a comma:

<table>
<thead>
<tr>
<th></th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1s</td>
<td>1</td>
<td>C1s</td>
</tr>
<tr>
<td>R.S.F. = 1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>GL(30)</td>
<td>GL(30)</td>
<td>GL(30)</td>
</tr>
<tr>
<td>Area = 302.2</td>
<td>4432.4</td>
<td>0.0, 1000000.0</td>
</tr>
<tr>
<td></td>
<td>Area Constr. = 0.0, 1000000.0</td>
<td>0.0, 1000000.0</td>
</tr>
<tr>
<td>Fwhm Constr. = 0.28, 7</td>
<td>1.4</td>
<td>0.28, 7</td>
</tr>
<tr>
<td>Position = 284.708</td>
<td>284.708</td>
<td>284.708</td>
</tr>
<tr>
<td>302</td>
<td>Pos Constr. = 302.208, 279.108</td>
<td>302.208, 279.1</td>
</tr>
<tr>
<td>C1s</td>
<td>1</td>
<td>C1s</td>
</tr>
</tbody>
</table>

Relational constraints involve specifying a parameter as related to a parameter from a second component in terms of an offset or a factor. For example, the area ratio of two peaks from a p-orbital doublet pair is in theory 2:1. To impose this theoretical relationship for a potassium doublet, for example, the following constraint forces the 2p_{3/2} peak to be twice the size of the 2p_{1/2} peak:
Relational constraints are defined in terms of the column header letters, thus to force the area of the peak in column A to be half the area of the peak in column B, the constraint entered in column A is “B*0.5”. Similarly, the FWHM can be defined as a factor constraint, while a position constraint is defined in terms of an offset to a second parameter.

**Line Shapes**

CasaXPS offers many different functional forms for synthetic components. The line-shapes are specified using strings entered into the line-shape field on the Components property page. Line-shapes are described in detail elsewhere in the CasaXPS manual; however the most commonly used synthetic line shapes are product Gaussian-Lorentzian GL(m) and sum Gaussian-Lorentzian SGL(m), where m=0 is a pure Gaussian and m=100 is a pure Lorentzian shape.

The line-shape LA(a,b,n) offers asymmetric line-shapes based on the Lorentzian functional form convoluted with a Gaussian.

A useful means of monitoring complex peak models is via a components annotation table displayed over the data.
Exporting Peak Models as Data

Peak model data are exported via the clipboard. Display the VAMAS block for which a peak model is prepared in the active tile and press the toolbar button. A clipboard selection dialog offering a table of data, where the table includes columns for binding energy, kinetic energy, spectral data in CPS, component data, the background intensities and the total synthetic envelope. These data can be saved as a TAB spaced ASCII file or copied onto the clipboard and pasted into software capable of accepting text data through the clipboard.
Quantification using Standard Reports

Quantification reports are text-based information generated from quantification regions and/or components defined on VAMAS blocks. The most common form for a quantification report is a tabulation of atomic concentrations calculated from regions on survey spectra.

The Report Spec property page on the Quantification Parameters dialog window provides the means of creating quantification reports from VAMAS blocks selected in the right-hand pane of the experiment frame. Creating a quantification table from regions on a survey spectrum involves:

1. Defining a configuration file.
2. Selecting the VAMAS block in the right-hand pane of the experiment frame.

The configuration files for the Standard Report section are a set of ASCII files located in the CasaXPS.DEF directory. These configuration files contain keywords, one per line, specifying the type of information included in the columns of the text base report. The configuration file for the Standard Report Regions button is called RegionQuantTable.txt.

The keywords listed in the file RegionQuantTable.txt are used to arrange the columns of the quantification report provided the Use Config File tick-box is ticked.
Selecting the VAMAS block in the right-hand pane before pressing the Region button causes a new view into the experiment frame to appear within the CasaXPS window.

The quantification table displayed in the new window can be copied through the clipboard or saved to disk by pressing the Copy toolbar button. Once on the clipboard, any program capable of accepting text from the clipboard may receive the data by requesting a paste action (usually Control-V).

To return to the experiment frame displaying the spectra either switch windows via the Window menu of CasaXPS or close the text report window.
Similar configuration files are available for configuring reports for each of the buttons in the Standard Report Section.

**Transferring Regions and Components to other Data**

Depth profiles are just one example of data sets where quantification information needs to be propagated throughout a set of similar spectra. The techniques described below are equally applicable to data from a range of experiments and apply to data spread over many VAMAS files as it does for data collected into a single experiment frame.

The propagation of quantification information to other spectra will be discussed using an example of a depth profile performed on a multi-layer material.

The data set consists of a set of survey spectra measured following a sequence of etch cycles. To examine the change in composition with etch time, the survey spectra require quantification regions appropriate for the entire set of spectra. Ultimately, each spectrum in the profile will have regions defined on it and therefore minor adjustments on a spectrum-by-spectrum basis are possible; however to obtain a reasonably good initial set of regions, the spectra are overlaid in the active tile so that all variations of the peaks can be assessed whilst defining the regions.
Create a region for each line in the survey spectrum representative of the elements present. First create a region for the O 1s peak using the element table method described above. Two chemical states of oxygen are clearly present in the data; however a single region will monitor the amount of oxygen in the profiled material.

Zoom into the Ti 2p peak envelope and add a region to measure titanium based on the Ti 2p peaks.

Similarly add regions for carbon and silicon.
The regions as the data stands are all defined on the first spectrum displayed in the active tile. The next task is therefore to propagate the regions from the first spectrum to the remaining set of spectra.

Ensure the spectrum for which the regions are defined is displayed in the active tile in the left-hand pane.

Select the set of survey spectra in the right-hand pane.
Move the cursor over the active tile displaying the spectrum for which the regions are defined and right-click the mouse. A Browser Operations dialog window lists the set of selected VAMAS blocks. Tick the Regions tick-box in the Propagate sections and press the OK button.

A progress dialog may appear briefly and on completion, the regions are transferred to the selected VAMAS blocks.
The objective for a depth profile is to display the variation of the signal as a function of depth. For this example, the depth will be measured in terms of etch-time; nevertheless, the type of report required to produce the profile differs from the format obtained from the Standard Report. To generate a profile as a function of time, the Custom Report section on the Report Spec property page is employed.

The custom report is designed for profiling experiments. The set of quantification items (regions and components) defined on the selected VAMAS blocks are listed in the Quantification Item Names table. From these quantification item names a set of named formulae are prepared.

NB: The name fields are used to define the relationships between the intensities in a profile. A special relationship is automatically applied to any quantification items assigned the same name. Specifically, if two quantification items have the same name then the intensity for the items
with the same name are added together. It is therefore very important to name regions and components with different names whenever a custom report is used.

Since the current example includes only regions, pressing the Region button transfers the region names into the table of names and formulae.

On pressing the Apply button in the Custom Report section, a column orientated quantification report is generated.

The text based report may be transferred through the clipboard to other programs or plotted within CasaXPS either as a separate file or appended to the current VAMAS file. Appending the profile data to the current file allows cross referencing the profile to the spectra. Both options are available on the File menu offered when the profile is tabulated.

Choosing the Add Profile menu option on the File menu adds the profile data to the original spectra as a temporary additional VAMAS file. The presence of a profile file is indicated in the bottom left-hand corner of the active tile.
To switch between viewing the spectra and the profile derived from the spectra, press Control-F8 on the keyboard. The profile view of the data set can be used to mark a set of etch times using a cursor drag-action coupled with holding the Shift Key down; on switching the display to the spectra using Control-F8, the set of etch times marked by the cursor become selected. Similarly, a contiguous selection in the spectrum view will determine the location of a cursor on the profile view of the data.

Copying Data to a New Experiment Frame
The depth profile VAMAS file continues to only contain the spectral data even after the Add Profile menu option is applied. To preserve a profile the VAMAS blocks containing the profile traces must be copied to a new experiment
frame. The new experiment frame can be saved once populated with the profile VAMAS blocks. To copy VAMAS blocks between experiment frames:

1. Select the VAMAS blocks in the right-hand pane.
2. Either, create a new experiment frame using the File menu or toolbar button, or switch focus to an existing experiment frame.
3. Press the Copy and Paste VAMAS blocks toolbar button.
4. Press the OK button on the Copy Selected VAMAS blocks dialog window.

The new experiment frame contains a copy of the VAMAS blocks.

**Annotating Spectra**

Text and tables are added to spectra via the Annotation dialog window.
Text may be added to the display as individual items of annotation. Each piece of annotation appears in a list on the Annotation History dialog window. The list allows the annotation items to be selected, amended and deleted using the options on the Annotation History property page.

The position of the annotation on the display is indicated by a small box next to the annotation text. Pointing the cursor at the box and dragging the cursor to a new position causes the annotation to move the moment the mouse button is released.

Modifying a piece of annotation involves selecting the annotation in the Annotation History list.
To alter the font, press the Font button and choose a new font for the selected annotation item.

Press the OK button on the Font dialog window and then press the Apply button on the Annotation History property page.
To adjust a specific annotation item, left-click the box located next to the annotation on the display. As a result, the annotation item is to move to the top of the list on the Annotation History property page. Initially Ce LMM text is not visible in the scrolled list without scrolling through the list.

[Image]

Left click the box beneath the Ce LMM annotation text on the display in the left-hand pane. Clicking the box causes the annotation item to move to the top of the list.

[Image]

Select the Ce LMM item on the Annotation History property page. To make the annotation horizontal rather than appearing in the initial vertical orientation, un-tick the Vertical Text tick-box and press the Apply button.
Auger Spectroscopy

Auger peaks in an energy spectrum are an indirect consequence of the excitation of core level electrons. Subsequent relaxation of the excited state induced by the interactions of a primary electron with an atom may result in the emission of an electron with a characteristic energy. These Auger electrons appear superimposed on a background of secondary and backscattered electrons.

The energy from the excitation source, typically an electron gun, alters the electronic state of an atom within the surface by ejecting a core level electron. The relaxation of the excited state occurs as a separate event from the core level excitation, so the characteristics of the excitation source have no influence on the energy with which Auger electrons are ejected from the surface. Auger electrons for an atom in a given chemical state always have the same energy regardless of the energy imparted by the primary electron beam or even when excited by other means such as x-rays. An oxygen Auger line, O KLL for example, appears at the same kinetic energy in a spectrum for both electron bombardment induced Auger or XPS induced Auger, regardless of the anode material in the x-ray gun.
Auger peak intensities do depend on the excitation source and therefore Auger element libraries must include relative sensitivity factors for the specific electron gun energy used to excite the surface material.

The Auger mechanism involves exciting a core electron followed by the decay of an outer electron to fill the core level. The new electron configuration is energetically unstable and results in the emission of energy by ejecting an electron with an energy characteristic of the intermediate states. These Auger transitions are often labelled using the letters assigned to the principal quantum numbers for the electronic shells: K, L, M, N, ... with subscripts differentiating the sub-shell structure.

For a more complete description of the Auger mechanism see Briggs and Grant ISBN 1 901019 04 7.

Auger Electron Spectroscopy (AES) is performed using a Concentric Hemispherical Analyser (CHA or HSA) or a Cylindrical Mirror Analyser (CMA).
The AES technique is offered in a stand-alone form and also as a multi-technique instrument, often including XPS to complement the advantages of AES. Sub-micron spatial resolution requires a means of isolating vibrations and Mu-metal shielding from stray electric and magnetic fields.

The following is concerned with spectra acquired using a CHA operating in fixed retard ratio mode or a CMA.

**Quantification of AES Data**

The acquisition mode for AES data determines the characteristics of the spectra and hence the quantification of peak intensities. CHA instruments typically have a response as a function of kinetic energy which behaves as an inverse power of the kinetic energy

\[ R(E) \propto \frac{1}{E^n} \]

where the exponent \( n \) is typically in the range 0.5 to 1. Historically AES spectra are measured using a fixed retard ratio FRR mode for the CHA. The FRR mode records the number of electrons reaching the detector as the kinetic energy of the ejected electrons is stepped such that the ratio of the initial kinetic energy of the electron to the pass energy of the analyser is maintained as a constant...
during the acquisition. A consequence of using FRR mode is that the energy resolution of the data changes with kinetic energy so that at high kinetic energy where the response of the CHA is reduced, the energy width accepted by CHA increases; the signal accepted by the CHA for electrons emitted with higher kinetic energy is greater than for lower energy electrons. The resulting spectra are therefore more uniform in intensity over a wide energy range. In particular, the high yield of secondary electrons at low kinetic energies is attenuated by the FRR mode, thus protecting the detector system from excessive count rates. As a result of these practical considerations, AES data are more difficult to quantify in terms of peak areas, therefore the method used to quantify Auger spectra is to measure the intensity of a transition using a differentiated spectrum, determining the peak intensity by the difference in the positive and negative going derivative peak heights.

The so called direct spectra, as recorded, must be numerically differentiated to provide the data in a form suitable for quantification in terms of peak to peak intensities.
Some instruments, in keeping with the past, acquire the data using hardware signal differentiation, which partially accounts for the quantification based on peak-to-peak intensities. Most AES spectra acquired from modern instruments are in direct mode and so must be numerically differentiated before quantification is performed.

The energy window for a CMA instrument is proportional to the kinetic energy of the analysed electrons. The CMA acquisition characteristics are therefore equivalent to data acquired using a CHA in FRR mode.

**Differentiation of Spectra**

Differentiating data in which noise is a component requires the use of a more subtle approach than Newton-Cotes differentiation. A least squares approach attempts to mitigate the influence of noise on the resulting derivative.

**Savitzky-Golay Method**

Two options on the Spectrum Processing dialog window commonly used for smoothing of experimental data and the determination of derivatives are performed using the algorithm proposed by Savitzky and Golay (A. Savitzky and M. J. E. Golay, Anal. Chem., 36, 1627 (1964)). The same algorithm is employed to differentiate spectra as is used to smooth data and therefore it should be clearly understood that the act of differentiating a spectrum using the Savitzky Golay method necessarily includes a smoothing operation.
Theory

Given a set of data containing both signal and noise, the initial objective of the Savitzky-Golay method is to replace the raw data by a smoother set of data representing the true signal responsible for the record intensities. For a constant underlying signal, the most natural means of estimating the true signal from a set of measurements would be to average the values. The act of averaging a set of values is in fact one example and possibly the simplest applications of the linear-least-squares principle. Spectral data, on the other hand, typically contain peaks superimposed on a background signal and therefore a more subtle use of averaging is required if the essential structure in the data set is to be retained. One way to use the averaging process, but to maintain information relating to the variation in the intensities, is to perform a local averaging for each bin within a spectrum; for example, each data bin could be replaced by the average of three bins, the bin itself and the two bins on either side of the bin. The averaging operation could be applied to a data set via a digital convolution of the data bins with a convolution kernel consisting of the values \{1/3, 1/3, 1/3\}. These simple, yet often used concepts are at the basis of the Savitzky-Golay method, which in essence applies the least-squares principle to determine an improved set of kernel coefficients for use in a digital convolution, where these improved coefficients are determined, in the least-squares sense, using polynomials rather than, for the case of averaging, simply assuming a constant value determined from a sub-range of data bins. Indeed, the Savitzky-Golay method could be seen as a generalisation of averaging data, since averaging a sub-range of data corresponds to using a Savitzky-Golay polynomial of degree zero.

To illustrate the Savitzky-Golay method, consider the specific example in which five data bins are used to approximate a quadratic polynomial. The polynomial can be expressed in the form:

\[ p(x) = a_0 + a_1 x + a_2 x^2 \]

where the coefficients \(a_0, a_1,\) and \(a_2\) are determined from the simultaneous equations in which the abscissa \(x\) is the index for the data bin; the origin is always placed at the central data bin, thus the abscissa values corresponding to each of the data bins are \{-2, -1, 0, 1, 2\}. 
or

$$A\mathbf{a} = \mathbf{d}$$

where the evenly spaced data bins \{d_{-2}, d_{-1}, d_0, d_1, d_2\} are selected with the target of replacing the value for \(d_0\) with the value for the polynomial at \(x = 0\) or \(p(0) = a_0\). Since there are five equations and only three unknowns, the coefficients to the polynomial must be determined in the least-squares sense, where the linearly independent basis functions are 1, \(x\) and \(x^2\). The normal equations yield:

$$A^TA\mathbf{a} = A^T\mathbf{d}$$

Since \(A^TA\) is a square symmetric matrix of rank three, the coefficient vector \(\mathbf{a}\) is determined from \([A^TA]^{-1}A^T\), the top row of which yields the prescription for computing the value of \(a_0\), namely:

$$a_0 = \begin{bmatrix} s_0, s_1, s_2, s_3, s_4 \end{bmatrix}^T \begin{bmatrix} d_{-2} \\ d_{-1} \\ d_0 \\ d_1 \\ d_2 \end{bmatrix}$$

Thus, for each set of five such data bins, the central bin can be replaced by the value determined for \(a_0\). In other words, a digital convolution using the five point kernel \(\{s_i\}\) and the raw data bins results in a smoothed set of data bins, where a linear least squares quadratic polynomial is used to model the data, five channels at a time.

Similarly, the derivative of a spectrum can be computed using the Savitzky-Golay polynomial. Again the intention is to approximate the derivative at a given point in the spectrum using the derivative of the polynomial at \(x = 0\). Since \(dp(0)/dx = a_1\), the second row of the matrix \([A^TA]^{-1}A^T\) yields a second convolution kernel for computing the derivative of the spectrum and, apart from the difference in the kernel values, the computation of the derivative proceeds in an analogous fashion to that of the smoothing calculation.

86
Creating Derivative Spectra for Peak-to-Peak Quantification

Direct spectra are converted to differentiated spectra using the Spectrum Processing dialog window.

The Differentiation property page on the Spectrum processing dialog provides a choice of two Savitzky Golay methods and a smoothing width value. The parameters used in the Savitzky Golay differentiation option depend on the source of the relative sensitivity factors used to quantify the data. For example, the set of RSFs in Appendix C of Briggs and Grant are designed for data acquired using an energy step size of 1 eV and differentiated using a 5 point quadratic Savitzky Golay differentiation method. Matching the acquisition step size and Savitzky Golay parameters is important because these influence the peak-to-peak height determined for an Auger peak. Consider a Gaussian peak with a FWHM of 7 eV tabulated at 1 eV and 0.5 eV step-sizes:
If differentiated using a 5-point quadratic Savitzky Golay method the peak-to-peak measurement for the same functional form differs by 10%.

The FWHM used for the Gaussian is typical of an oxygen KLL peak. The scale of the difference between peak-to-peak intensities for peaks of different FWHM when measured using different step-sizes also varies. A peak-to-peak intensity for a peak with FWHM 10 eV when measured using 1 eV and 0.5 eV and differentiated using a 5-point Savitzky Golay method differs by 5%.

The RSFs in Briggs and Grant are specified for a 4 eV energy interval numerical differentiation. In principle data acquired at 0.5 eV should therefore be differentiated using a 9-point Savitzky Golay method, while data acquired at 1 eV would require a 5-point Savitzky Golay differentiation. While matching the number of points used in the Savitzky Golay method to the step-size can improve the acquisition step-size dependency, the test peak of FWHM 7 eV
still results in a 1.8% difference in peak-to-peak height when tabulated at 0.5 eV steps and differentiated with a 9-point quadratic Savitzky Golay than when tabulated at 1 eV and differentiated with a 5-point quadratic method.

Converting Direct Spectra to Differentiated Spectra

To convert a spectrum from direct form to differentiated form:

1. Display the spectrum in the active tile.

2. Invoke the Spectrum Processing dialog window and select the Differentiation property page.

3. For data acquired using 1 eV step-size, select the SG Quadratic radio button and enter 5 into the smoothing width text box.

4. Press the Apply button on the Differentiation property page.
An entry appears in the scrolled list on the Processing History property page.

Only the spectrum in the active tile is affected by the Differentiation property page. When other spectra are included in the experiment and also require differentiation, the processing performed on the spectrum in the active tile can be propagated to data selected in the right-hand panes of the experiment frame as follows:

1. Display a spectrum in the active tile for which the differentiation operation is already performed and the Processing History property page displays the text string for the differentiation instruction (e.g. Diff SG D(2) P(5)).
2. Select the data blocks in the right-hand pane for which the differentiation operation is also required.

3. Place the cursor over the active tile in the left-hand pane and invoke the Browser Operations dialog window by right-click the mouse button.
The Browser Operations dialog window lists those VAMAS blocks selected in the right-hand pane of the experiment frame and offers a set of tick-boxes which specify the type of information to be propagated from the VAMAS block displayed in the active tile to the set of VAMAS blocks in the scrolled list.

4. Check the list of selected VAMAS blocks on the dialog window and tick the propagate Processing tick-box.

5. Press the OK button on the dialog window and confirm that the data are now displayed as differentiated spectra.
Quantification Regions for AES data

Peak-to-peak intensities are measured using quantification regions. Quantification regions specify:

1. The name for the region; also referred to as the quantification item name.
2. The relative sensitivity factor, labelled RSF, for the peak intensity.
3. The energy interval over which the peak-to-peak intensity should be determined.

Quantification regions are used for XPS data and therefore other fields such as background type are also present on the Regions property page, but for peak-to-peak measurements these other fields are of no importance.

The Quantification Parameters dialog window is available from the Options menu or via the top toolbar.

A region is manually specified using the Regions property page on the Quantification Parameters dialog window:
The name field in the quantification region is used to label the values computed for the region in quantification reports.

Meaningful names improve the readability of quantification reports. Further, the name field is used for manipulating intensities in the Custom Report used for depth profiling experiments and therefore region names used in the Custom Report should begin with an alphabetic character.

The peak-to-peak intensity is scaled using the RSF field on the Regions property page.
The RSF is typically stored in the element library and retrieved using the Element Library dialog window as described below. The energy interval over which the peak-to-peak intensity is computed is defined using two limits labelled start and end.

While the background type for peak-to-peak intensities is irrelevant from the computational point of view, from a display perspective a background type of zero provides a more meaningful reference than the typical XPS background types.

Creating Quantification Regions using the Element Library

The advantage of creating quantification regions using the element library lies in an explicit selection of the transition and therefore RSF appropriate for the Auger peak. Regions are created using the Element Table property page.

The scrolled list on the Element Table property page combines with the Regions property page on the Quantification Parameters dialog window to create regions for the spectrum displayed in the active tile.
To create a region using the Element Table property page:

1. Display a spectrum in the active tile.
2. Invoke both the Quantification Parameters and Element Library dialog windows.
3. Left-click the mouse with the cursor over the Auger peak in the left-hand pane of the experiment frame. The table on the Element Table property page scrolls to display those energies around the energy indicated with the cursor and mouse.
4. Tick the box on the Element Table property page labelled Create When Line Selected.
5. Ensure the Regions property page is top-most on the Quantification Parameters dialog window.
6. Using the name field on the Element Table list, select the transition corresponding to the data in the active tile.
A region is created with name and RSF assigned from the element library entry selected.

7. Adjust the start and end for the quantification region by either entering new values on the Regions property page or under mouse control.

Propagation of Quantification Regions

A region defined on a spectrum can be propagated to other spectra for the same transition. The propagation of regions is analogous with the propagation of processing operations described above in the context of differentiating a data set of many direct spectra.

To propagate a region:
1. Display the spectrum for which a region is defined in the active tile.
2. Select the set of VAMAS blocks in the right-hand pane to which the region in the active tile is to be copied.

3. Right click the mouse with the cursor over the left-hand pane and select the tick box labelled Regions in the Propagate section of the Browser Operations dialog window.

4. Check that the scrolled list on the dialog window contains the intended set of VAMAS blocks and press the OK button.

On completion, the set of spectra selected in the right-hand pane are populated with copies of the region or regions defined on the spectrum in the active tile.
Quantification reports are generated from those VAMAS blocks selected in the right-hand pane of the experiment frame for which regions are defined. The Report Spec property page on the Quantification Parameters dialog window offers the two principal mechanisms by which quantification reports are generated, namely, Standard Reports and Custom Reports.

The Report Spec property page offers the means of quantifying data acquired as separate narrow scan spectra. The spectra used to quantify a surface composition must be displayed in the same row as viewed via the right-hand pane of the experiment frame.
The organisation of the VAMAS blocks in the right-hand pane is based on the element (species)/transition VAMAS fields in the data blocks and the experimental variable assigned to the VAMAS block. The values for these VAMAS block parameters may be altered using several toolbar options.

The Edit VAMAS fields dialog window acts on the data displayed in the active tile. Other dialog windows act on selections in the right-hand pane.
VAMAS blocks with the same element/transition fields appear in the same column in the right-hand pane, while VAMAS blocks with the same experimental variable appear, where possible, in the same row.

**Standard Reports**

Standard reports are configurable row-orientated reports generated from survey and/or narrow scan spectra measured from the same surface. Creating a quantification report involves:

1. Creating quantification regions for each peak used to characterise the sample.
2. Selecting in the right-hand pane the VAMAS blocks containing the spectra for which regions are defined.
3. Invoking the Quantification Parameters dialog window and selecting the Report Spec property page.

When the Regions button is pressed, if the Use Config File tick-box is ticked a configuration file is used to define the information appearing in the text report. A detailed discussion regarding these configuration files is presented in a later section. The report generated from one specific configuration file appears as a text report in CasaXPS.

A quantification report generated from the standard report options is copied through the clipboard by pressing the Copy toolbar button or Control-C at the time the text report window has focus in CasaXPS.
Any program capable of accepting text via the clipboard can be used to further manipulate the data. The data placed on the clipboard includes a variety of tabulation formats, not all applicable to peak-to-peak data.

**Configuration Files for Standard Reports**

The configuration files for the standard report are constructed from a set of keywords entered into an ASCII file one keyword per line. The keywords are:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VARIABLE</td>
<td>Experimental Variable value from the VAMAS block or Row Label when in Edit Mode</td>
</tr>
<tr>
<td>NAME</td>
<td>Region or component name.</td>
</tr>
<tr>
<td>POSITION</td>
<td>Peak position.</td>
</tr>
<tr>
<td>FWHM</td>
<td>Peak full width at half maximum.</td>
</tr>
<tr>
<td>AREA</td>
<td>Peak area correct for transmission and energy dependence but not RSF</td>
</tr>
<tr>
<td>RSF</td>
<td>Relative Sensitivity Factor</td>
</tr>
<tr>
<td>CONCENTRATION</td>
<td>% Atomic Concentration</td>
</tr>
<tr>
<td>ERROR_BAR</td>
<td>Std Deviation in % atomic concentration for regions</td>
</tr>
<tr>
<td>START</td>
<td>Quantification region lower limit</td>
</tr>
<tr>
<td>END</td>
<td>Quantification region upper limit</td>
</tr>
<tr>
<td>PEAK_TO_PEAK</td>
<td>Intensity for peak to peak Auger Peak intensity maximum to minimum XPS/SIMS peak height above background</td>
</tr>
<tr>
<td>PEAK_TO_PEAK_CONC</td>
<td>% Concentration measured using peak to peak intensity</td>
</tr>
<tr>
<td>LINE_SHAPE</td>
<td>Synthetic line-shape for a component</td>
</tr>
<tr>
<td>AREA_ERROR_BAR</td>
<td>Std Deviation in peak area measured using a quantification region</td>
</tr>
<tr>
<td>TRANSITION_TAG</td>
<td>Tag string from region or component</td>
</tr>
<tr>
<td>POSITION_CONST</td>
<td>Component position constraint string</td>
</tr>
<tr>
<td>AREA_CONST</td>
<td>Component area constraint string</td>
</tr>
<tr>
<td>FWHM_CONST</td>
<td>Component FWHM constraint string</td>
</tr>
<tr>
<td>COLUMN_LABEL</td>
<td>Column character appearing above a region or component on the respective property page</td>
</tr>
<tr>
<td>DEGREES_OF_FREEDOM</td>
<td>Degrees of freedom used to compute the figure of merit from least squares fit.</td>
</tr>
<tr>
<td>VAMAS_BLOCK_NAME</td>
<td>VAMAS block identifier</td>
</tr>
<tr>
<td>CENTROID</td>
<td>Position of the centroid of a peak</td>
</tr>
<tr>
<td>MASS</td>
<td>Mass assigned to a region or component</td>
</tr>
<tr>
<td>MASS_CONC</td>
<td>% Mass Concentration</td>
</tr>
</tbody>
</table>
Notepad or any other means of creating an ASCII file can be employed to create the configuration files.

The configuration file used to generate the standard report is located on the disk relative to the directory containing the CasaXPS.exe executable file. Within the same directory as the CasaXPS.exe executable file is a directory called CasaXPS.DEF. Default settings enabled on starting a new CasaXPS session are also saved in the CasaXPS.DEF directory.

Each type of configuration file for the standard report options is identified by key names; specifically, the file called RegionQuantTable.txt provides the configuration information for the columns in the standard report generated when the Regions button in the standard report section is pressed. Similarly, other configuration files with key names are associated with the other reporting options in the standard report section. These configuration files are used by default each time a standard report is requested and are most appropriate for those users requiring a fixed format for each report generated.

A further feature allows a choice of configuration files. If a directory exists in the CasaXPS.DEF directory by the name of QuantTables, then on pressing a standard report button the user is offered a list of configuration file. The report format is dependent on the choice made from the list.
Since all files in the directory CasaXPS.DEF/QuantTables are offered in the dialog window, the names of the files within the QuantTables directory are unimportant and therefore the correct configuration file for the type of data must be selected.

To quantify the Auger survey:
Select in the right-hand pane the VAMAS block containing the AES survey spectrum and press the Regions button from the Standard Report section.
On the resulting dialog window, select the configuration file from the list and press the Select button. The quantification table appears with column headings defined by the configuration file.

A different report is obtained from a similar sequence of steps for the XPS survey spectrum recorded from the same sample and located in the same VAMAS file. By selecting the configuration file prepared for XPS data an appropriate report is selectively produced; XPS spectra are typically quantified using peak area after background subtraction rather than the peak-to-peak approach of Auger spectra.
In the event no selection is made from the dialog window invoked by pressing the Regions button, the default configuration file for the Regions button is used to generate the report. The default configuration file for the Regions button on the Standard report is located in the CasaXPS.DEF directory with the key name RegionQuantTable.txt.

The selection dialog window only appears if the QuantTables directory exists in the CasaXPS.DEF directory. The default configuration file for the Regions button is automatically used if the CasaXPS.DEF directory is prepared without the QuantTables subdirectory.

**Custom Reports**

Custom reports are not configurable and data are presented in columns with each row of the table associated with an experimental variable. The intention is to provide a means of profiling changes in spectra with respect to etch time or angle or any parameter that varies through the course of an experiment.
The Custom Report, like the Standard Report, only applies to the current selection in the right-hand pane of the experiment frame. Regions and components are treated identically within the custom report and are referred to as quantification items, where both forms of these quantification items are identified by the name fields used in the definition of the regions and components. When a VAMAS block is selected in the right-hand pane, all the region names and component names are collected into a list displayed under the heading Quantification Item Names.

Only quantification item names appearing in the Quantification Item Names list are used in the custom report.

A custom report is defined in terms of the currently active quantification item names using the Name and Formula table.

The Names and Formula table can be initially populated using the set of buttons between the two tables. Pressing the Regions button between the
Quantification Item Names table and the Names and Formula table causes the set of unique region names currently displayed in the Quantification Item Names table to be transferred to the Names and Formula table. The Names and Formula entries can be edited by right-clicking the mouse with the cursor over a name entry in the lower table.

The function of the buttons between the two tables is to provide an initial state for the Names and Formula table. Although the action apparently loads the Names and Formula table using information from Regions, for example, it is important to note that any component with the same name as a region will also be included in the custom quantification report regardless of whether the Region button was initially pressed. The objective for the custom report is to provide a flexible means of combining intensities from both regions and components, so to differentiate between regions and components different name should be used.

A further word of warning is that any quantification item with identical names will be summed together. This feature makes it doubly important that regions and components should be assigned different names. The consequence of not using unique names for regions and components is the intensities will effectively be doubled for any spectrum for which a region defines the background for a component. Peak fitting with components is rarely performed for Auger spectra, so this warning is less important for Auger as for
those using XPS, but nevertheless, custom reports will sum regions with identical names therefore an awareness of the mechanism is important.

For the purposes of profiling the data being used as an example, initially a custom report simply based on the region names is sufficient. To create the Names and Formula entries:

1. Select the VAMAS blocks containing the quantification regions previously prepared.

2. Press the Regions button between the two tables in the custom report section.

3. Since the data are in derivative form and therefore peak-to-peak intensities and RSFs are in use, press the Height Report button in the custom report section.
The resulting quantification table represents two sets of traces, namely, a set of corrected peak intensities in CPS and a set of atomic concentrations expressed as a percentage. These data may be placed on the clipboard using the Copy toolbar button (or Control-C) and pasted into plotting software or further manipulated in CasaXPS. A VAMAS view of the profiles is obtained either as a separate VAMAS file or within the current spectrum file using the File menu offered while the report window has focus.

The Create Profile menu option causes a new experiment frame to appear containing two rows of VAMAS blocks. The top row corresponds to the atomic percentage columns in the quantification report, while the second row in the new experiment frame corresponds to the RSF corrected peak-to-peak intensities.
The second option for displaying the profile data allows the features in the profile to be correlated with the spectra from which the profile is derived. Selecting the Add Profile menu option from the File menu causes the profile data to be added to the original VAMAS file containing the spectra. When a profile is added to the spectral data, a string is added to the display of the spectra in the active tile.

The string Ctrl+F8 Profile indicates that holding down the Control key on the keyboard and pressing the F8 function key cause the display to switch from spectra to the most recently added profile data.
A raw Auger depth profile may therefore be viewed in spectrum format, where rows of spectra ordered with respect to etch-time, and processed profile format, where traces computed from the spectra are plotted against etch-time. The Control+F8 key stroke not only switches between the two perspectives of the data, but also changes the display of the spectra based on the position of the cursor when viewed in profile format, or the displayed position of the cursor in the profile format based on the selection in the right-hand pane when viewed in spectrum format. The row currently selected in the spectrum format of the profile, and therefore the etch time, translates into position of the cursor on the profile format of the data. Similarly, a cursor placed on the profile format of the data becomes a selected row of spectra when the Control+F8 action is pressed causing the display to revert back to the spectrum format.

It is also possible to indicate a range of spectra via the normal selection mechanism in the right-hand pane of the experiment frame displaying the spectra. On pressing Ctrl+F8, a pair of vertical cursors indicates where in the profile the selected spectra correspond in the profile. Again, if a pair of vertical cursors is placed on the profile trace, on switching back to the spectrum form of the data, the range of spectra indicated by the cursors on the profile becomes selected in the right-hand pane of the spectrum form of the data.

To mark the profile with a pair of cursors, hold the Shift key down while dragging the cursor across the active tile displaying the profile. On releasing the mouse button, the drag box marks the position of the two cursors.

**An Advanced use of the Custom Report**
The profile used to illustrate the custom report involves erbium and molybdenum. The basic profile created using region intensities suggests a correlation between the molybdenum layer and the erbium surface layer.
Since the erbium Auger peak used in the profile is located near a molybdenum peak, examining the intensity of the erbium will require a more detailed analysis than simply following the profiles of region intensities. Examining the direct spectra at etch-times close to the molybdenum interface confirms the influence of the molybdenum Auger line on the intensity measured for erbium.

It is therefore proposed to calculate the erbium intensity using the molybdenum region to remove the molybdenum peak-to-peak intensity contribution from the erbium region. To estimate the relationship between the peak-to-peak intensity for the molybdenum interference and the Mo1 Auger transition, a representative pair of spectra is selected and used to measure the intensity ratio of the Er1 region to the Mo1 region, where it is assumed the Er1
region is at a point in the profile such that the erbium signal is negligible compared to molybdenum.

Measuring the ratio of these molybdenum peaks can be performed using the custom report:

1. Select the two VAMAS blocks containing the erbium and molybdenum data for an etch-time where erbium is not significant.

2. Select the Mo1 name in the Quantification Item Names table on the Custom Report section of the Report Spec property page before pressing the Ratio Region button.

The Names and Formula table is populated with formulae involving a simple division with respect to the Mo1 quantification items selected in the table above. Pressing the Height Report button followed by the Copy toolbar button results in a dialog window from which the ratio can be selected, copied, and then pasted into a new set of formulae for profiling the full experiment.
To profile the full experiment:
1. Select all the VAMAS blocks for which regions are defined.

2. Press the Regions button between the Quantification Item Names table and the Names and Formula table.
3. Right-click with the cursor over the name field for the Er1 entry in the Names and Formula table.

4. Enter the formula for the modification to the erbium intensity based on the ratio previously determined.

5. Press the Height Report button on the Custom Report Section.
The custom report table can again be exported using the Copy toolbar button, or a VAMAS form of the profile can be created using the File menu.
Ideally, the relative intensity of the Mo1 peak to the molybdenum peak measured at the same energy as the erbium should have been measured using a molybdenum standard rather than assuming a value computed from the profile data. An alternative to manipulating the peak intensities via the custom report is to use a least squares approach to separate the erbium from molybdenum interference.

**Least Squares Approach to Depth Profile Interpretation**

A least squares procedure offers a means of partitioning a spectrum into component spectra. The component spectra are chosen to embody the transitions responsible for the measured data. Once these component spectra are determined in a least squares sense, the relative contributions of these underlying transitions to the measured data can be identified using quantification regions in exactly the same way any spectrum in the profile is quantified.

The least squares procedure is described in the context of the Savitzky Golay algorithm for differentiating the Auger direct spectra. The essential difference in the least squares decomposition of spectra compared to the Savitzky Golay algorithm is the basis functions are now spectra rather than terms \( 1, x, x^2, \ldots \) in a polynomial. The net result is the same in the sense that a spectrum \( s \) is expressed as a linear combination of a set of \( n \) component spectra \( c_i \).

\[
\begin{align*}
    s & \equiv \sum_{i=1}^{n} a_i c_i \\
\end{align*}
\]

The coefficients \( a_i \) are determined in a least squares sense and the spectrum \( s \) is therefore decomposed into component spectra \( a_i c_i \).

By way of example, the erbium/molybdenum problem will now be addressed using a least squares decomposition.

**Least Squares Example**

While the data in the Auger depth profile will be quantified using the differentiated spectra, since the act of differentiation involves a Savitzky-Golay operation which effectively smoothes the data, the least squares analysis will be performed on the raw direct spectra rather than working with already processed differentiated data.

The first step is to identify the component spectra for use in the least squares decomposition. Overlaying the Er1 VAMAS blocks in the active tile offers an
easy partition of the data into three forms: pure erbium, predominantly molybdenum, and background signal measured at depths below either the erbium and molybdenum layers.

In general it is good practice to improve the signal to noise ratio in the component spectra by adding together appropriate sets of spectra from the three zones identified. While the Calculator property page on the Spectrum Processing dialog window provides a means of combining spectra acquired under varying conditions, the data from the depth profile are very uniform in the acquisition parameters; therefore, summing a set of spectra such as these is achieved in a simple fashion using the Test Data property page on the Spectrum processing dialog window.

The Test Data dialog window offers a range of miscellaneous processing options, two of which permit data to be summed without regard to acquisition conditions. That is, these options are only appropriate for very specific cases in which all the spectra have identical numbers of data channels. To sum data from a set of VAMAS blocks:

1. Select an appropriate set of spectra over which a summation can be performed.
2. Invoke the Spectrum Processing Dialog window and select the Test Data property page.
3. Overlay the selected VAMAS blocks in the active tile.
4. Press the SUM button on the Test data property page.

Note: the SUM All button should **not** be used as the SUM All button includes each corresponding variable in each VAMAS block in the summation. Most spectra include transmission function information as a corresponding variable; therefore, the resulting spectrum would be incorrect if the SUM All button were used. The SUM All button is used for imaging data sets where spectra-at-pixels appear in the VAMAS file as corresponding variables in VAMAS blocks. Following the use of the SUM button acting on the spectra overlaid in the active tile, a new VAMAS block appears in the right-hand pane which contains the sum of the spectra appearing in the active tile.
For the current example where three zones within the profile are identified, the summation steps need to be repeated for the molybdenum layers and also the layers beneath both the erbium and molybdenum layers. The resulting experiment frame now contains three additional VAMAS blocks appended to the column headed Er1. Adjusting the VAMAS block identifiers for these three summed spectra helps to understand the context of these data in the experiment frame created by the linear least squares procedure. The toolbar option for editing the block identifier applies to the VAMAS blocks selected in the right-hand pane.

Having created the three component spectra, select and overlay the component spectra in the active tile.
The component spectra overlaid in the active tile are used to fit the spectra selected in the right-hand pane. To create an experiment frame containing the least squares decomposition of the erbium spectra:

1. Select the column of erbium spectra.
2. Invoke the Spectrum Processing dialog window and select the PCA property page.
3. Press the Generate Spectra button in the Linear Analysis section of the property page.

A new experiment frame opens containing a row for each VAMAS block selected in the original experiment frame containing the depth profile. Each row includes the original VAMAS block followed by the least squares approximation to the original spectrum based on the component spectra, followed by each scaled component spectrum.

In order to profile the erbium signal, the column in the new experiment frame corresponding to the scaled erbium component from the least squares decomposition must be copied back to the original depth profile experiment frame. Once the erbium component is returned to the originating data file, the
profiling steps can be followed where the unprocessed erbium spectra are replaced in the profile by the new least squares component data.

To copy the erbium components:

1. Select the column of VAMAS blocks representing the erbium component spectra.

2. Switch focus to the original experiment frame and press the Copy/Paste toolbar button.

The VAMAS blocks corresponding to the components are now moved to the original experiment frame.
Since the component erbium spectra represent the contribution of the erbium only, the profile is now performed as before based on simple regions where the component spectra replace the role of the raw erbium spectra. That is, the component spectra require differentiating and a region created for the Er1 transition before the profiling steps are repeated for the file. The raw Er1 spectra are not included but are substituted by the component spectra.

The profile created by this method also removes the apparent correlation previously obtained by the basic analysis of the profile with simple regions.
**Linear Least Squares**

While the linear least squares approach is a powerful tool when used correctly, the least squares criterion may produce poor representations of the original spectra due to an incomplete set of component spectra. For this reason, the results of a linear least squares decomposition are offered in a new experiment frame with the view to assessing the validity of the decomposition. Overlaying the raw spectrum together with the least squares solutions provides a visual feedback of how well the procedure applied to the profile data.

A useful option for displaying the spectra generated from the least squares procedure is the Tile by Row toolbar button.
Selecting a set of rows in the right-hand pane before pressing the toolbar button causes the creation of one display tile per row of selected VAMAS blocks in the right-hand pane where each tile appearing in the left-hand pane displays an overlay of spectra from a row of selected VAMAS blocks.

**CasaXPS Element Library**

Elemental identification and quantification using XPS/AES spectra rely on the maintenance of libraries containing peak positions and relative sensitivity factors. The default CasaXPS element library is compiled using rough peak positions and Scofield cross-sections for aluminium and magnesium X-ray anodes to represent the corresponding relative sensitivity of the photoelectric peaks relative to the C 1s transition. While appropriate for some, these peak energies and relative sensitivity factors will not satisfy all and therefore the CasaXPS system offers mechanisms for user, technique and sample specific element library creation. This section describes the means for modifying the element library in CasaXPS.

**Element Library Format**

The CasaXPS element library is an ASCII file. The first line in the file is a version number, which may be 0, 1 or 2. Library files updated from version 2.3.15 of CasaXPS are written in version 2 format. The format for version 1 and version 2 files is TAB spaced ASCII organised so that the data are easily edited in a spreadsheet program such as Excel. The difference between version 2 and version 1 formatted files is simply the ability of the version 2 format to include additional user-defined TAB spaced fields appended to the end of the standard
set of fields defined for version 1 library files. Each entry within an element library file consists of the following standard fields:

1. Element
2. Transition
3. Label/Name
4. Mass (Daltons)
5. Energy Type (BE or KE)
6. Energy (eV)
7. F.W.H.M.
8. Line shape (e.g. GL(30))
9. Relative Sensitivity Factor
10. Excitation source string

These standard fields when viewed via a spreadsheet appear as follows:

For a large number of changes, using a spreadsheet is the best means of constructing a CasaXPS library; however, for small alterations the Element Library property page offers dialog-window-based adjustments of the library. Note how the library entries visible in the spreadsheet include two different excitation source strings, namely Al and Mg. A single library file may contain any number of entries corresponding to different excitation source strings; however, when used in CasaXPS these strings are matched to the excitation source string in the displayed VAMAS block in the active tile. Only those library entries for which a match occurs are displayed on the Element Table property
page of the Element Library dialog window. Thus, an XPS spectrum displayed in
the active tile measured with an Al anode, and therefore assigned a source
label of Al, will cause the Element Table property page to list only those
element library entries with matching excitation strings.
The transitions listed because of a match between the excitation source string
and the VAMAS block source label field are supplemented by transitions with
excitation source entries identified using the string Any. These additional
element library entries with excitation source string Any are for XPS induced
Auger transitions, the function of which is to simply mark the position of Auger
lines in any XPS spectrum. Since these Auger lines do not specify lines used in
quantification, the RSF for these Auger lines is typically zero. An XPS induced
Auger line for which an RSF has been established may be entered into the
library using an Energy Type of KE and excitation source string appropriate for
the data.

![Image of the Element Library dialog window with transitions listed]

The element table offered for the XPS spectrum should be compared to the
entries displayed from the same element library file when the data in the
active tile is an Auger spectrum.
The transitions offered in the element table are specific to the Auger data in the active tile. When the Source Label field for the data includes the string *electron gun*, the string used to match the entries in the element library is constructed from the electron gun energy parameter in the VAMAS block. Hence, in the current example data, since the electron gun energy is 3000 eV, the string used to display the Auger transitions in the element table is S(3).

Although version 2 of the library format is aimed at editing library files within a spreadsheet program, a mechanism exits within CasaXPS for making occasional changes and additions to the currently loaded library file. The Edit Entry dialog window is invoked by placing the cursor over the Name field for an entry in the element table before right-clicking the mouse button. The current set of library fields for the selected peak is displayed on the dialog window. These fields can be adjusted, then either updated or a new entry created.
The Edit Entry dialog window allows the library entry to be altered and then updated using the OK button. Alternatively, pressing the Create button causes a new library entry to be added to the element library based on the parameters defined on the dialog window. The Delete button will remove the entry used to invoke the dialog window.

Any modifications to the element library within CasaXPS are only written back to disk once the current session of CasaXPS is ended. On exiting CasaXPS, a File dialog window presents the opportunity to save the changes to a new filename.

On starting CasaXPS, the library file CasaXPS.lib located in the same directory as the executable file CasaXPS.exe is loaded as the default element library. In general, when a spectrum is displayed in the active tile, on invoking the Element library dialog window, the Element Table property page displays those entries for which the excitation source string from the entry matches the corresponding field in the VAMAS block holding the spectrum. The exception to this rule occurs for AES data. If the excitation source field in the VAMAS block is set to a string including the key words electron and gun, then for Auger spectra the electron gun energy is used to construct the string used to match an excitation source in the element library. For example, an AES element library might include relative sensitivity factors for electron beam energies 3 keV, 5 keV and 10 keV, and therefore should have entries with excitation source strings S(3), S(5) and S(10).
A set of sensitivity factors for AES are published in the book edited by Briggs and Grant (ISBN 1 901019 047); different instrument manufacturers recommend different sensitivity factors for specific instruments, so an appropriate library for a given instrument should be prepared.

**Importing a JEOL Element Library**

A file format used by JEOL Auger instruments is supported in CasaXPS as a means of importing transition and RSF information into the CasaXPS element library. The file format is a relatively simple format.

Importing these files into CasaXPS involves the Input File property page on the Element Library dialog window.

To import a JEOL formatted file:
1. Using the File dialog invoked by the Browse button, browse for the ASCII file. Select the file and press the Open button on the File dialog. The selected file is entered onto the Input File property page.

2. Select the radio button labelled JEOL AES.

3. Enter the information into the element library by pressing either the Load button to overwrite the existing element library or Merge button to add the new entries to the current element library.

The JEOL library files include an entry specifying the electron gun energy; therefore a JOEL formatted file is required for each electron-gun energy. In addition, the JEOL library files are either for differentiated spectra peak-to-peak measurements or direct spectra measurements. The two different files contain different RSF values depending on the type of spectra analysed during quantification.

**Concentration Calculation**

The principal means of comparing XPS/AES samples in CasaXPS is via percentage concentration values. The names assigned to these quantities are an indication of the source for the values rather than an assertion that the tables necessarily contain atomic or mass concentration for the surface material. The accuracy of these concentration values depends on appropriate transition and instrumental specific corrections as well as matrix context for the material analysed. The objective in using concentration values to characterise a sample is to reduce the intensity values to a set of normalised quantities in the hope that some of the measurement artefacts are removed from consideration when different samples are compared.

A concentration calculation consists of determining intensities for the transitions computed from the raw data $I_i$, followed by a correction based on the transition, encapsulated in the RSF $R_i$ and, where available transmission correction $T(E)$ accommodating instrumental intensity variations. The concentration $X_i$ for an element is given by

$$X_i = 100 \frac{A_i}{\sum_{i=1}^{m} A_i}$$

$$A_i = \frac{I_i}{T(E)R_i}$$
The intensity $I_i$ may be measured using peak height above background, peak-to-peak or peak area. For mass concentration the raw intensity is multiplied by the mass for the element. The essential feature for these quantities is the normalisation to the total signal measured.

While the standard method for measuring intensity for Auger spectra is based on peak maximum to peak minimum (peak-to-peak) within a quantification region, other methods are possible within CasaXPS. Extracting these alternative intensity values is dependent on the background type used within the quantification region.

To reveal the set of possible background types, hold the Control Key down and left-click the mouse with the cursor over a background type string on the Regions property page of the Quantification Parameters dialog window.

The alternative methods from peak-to-peak for computing peak intensities are for spectra in direct mode:

1. Peak height above background, where the background intensity is measured at the left hand side of the quantification region.
2. Peak height above background, where the background intensity is measured at the right hand side of the quantification region.
3. The ratio of the Peak height above background to the background intensity.

The background types corresponding to these options are Height Left, Height Right and (P-B)/B.

Height Right:
Height Left:

(P-B)/B:
The ratio of peak height above background divided by the background intensity is a means of normalising the peak intensities with respect to background variations. These ratios are sometimes referred to as topographical corrections when used in the context of imaging where peak and background images are measured. Imaging Auger instruments without hardware signal differentiation necessarily measure images in direct mode and therefore these intensity measures provide insight into the quantities exploited by imaging instruments.

**Auger Imaging in CasaXPS**

The electron gun technology required for Auger spectroscopy is also capable of generating spatially monitored Auger signal and therefore Auger imaging is often included as an option. Submicron spatial resolution requires vibration isolation and screening of stray electromagnetic fields within the analysis chamber to allow precise scanning Auger microscopy (SAM). Not all Auger instruments include such additional engineering, but nevertheless imaging is a natural feature of Auger systems.

Auger images, when measured at a peak maximum are often difficult to interpret. Fluctuations in the signal as a function of position on the sample causes variation in the pixel intensities independent of the chemical information desired from the surface of the material. The difficulty arises because Auger images are typically collected in direct mode at the peak maximum and unlike spectral measurements, are often taken in isolation; background variations are sufficient to hamper the interpretation of such images. In an attempt to reduce these effects, images are often also acquired at an energy representative of the background and sometimes at a second background energy, with the view to including a contribution from the background to the final image and thereby improving the estimate of the peak
height at each pixel. A common calculation for an Auger analysis is the, so called, topographical correction computed from the peak maximum $N_1$ and a background image $N_2$, namely $\frac{(N_1-N_2)}{N_2}$. A variation on a theme is to compute an image from $\frac{(N_1-N_2)}{(N_1+N_2)}$.

The principal reason for analysing Auger images using peak and background intensities is the time constraint of doing more; however, the benefits of applying spectroscopic techniques to image analysis may, when possible, outweigh the time penalty of performing the extended acquisitions of images and allow spectra at each pixel to be determined. The example examined below (data provided by Pennsylvania State University, USA), is a simple experiment in which a gold grid is placed over a clean silver surface, and a set of Auger images are acquired at unit eV step size across a silver Auger peak. As luck would have it, a weak gold Auger line is also included in the energy range over which the images were recorded and therefore the data set offers a means of illustrating a simple, yet effective procedure for creating elemental Auger images. Viewing the full set of images in the raw direct mode intensity leaves the impression that the grid is silver rather than gold.

Rather than using the direct spectra, following the conventional wisdom for Auger spectra, the data are differentiated and peak-to-peak measurements made for each pixel in the image. Simple quantification regions are defined on the spectra, one for the silver Auger line and one for the weak gold Auger line.
Two images of the peak-to-peak intensities are constructed; these two images in turn are quantified using the standard procedure for quantifying spectra.

The results are two images, where the silver image is free from intensity variations other than the elemental surface composition. A comparison with an image obtained from a topographically corrected intensity shows how the normalisation to the total intensity for both Ag and Au regions eliminates to a greater extent the shadowing from the gold grid on the silver.

Regardless of which of the three methods are used to process the raw Auger images, the most striking point is all three methods recover the true composition of the grid, namely, gold rather than silver.
In many ways, the improved quality of the gold and silver images are reassuring, since for years it has been assumed Auger spectra taken from a single point on a sample can be compared by determining atomic concentrations from the relative intensities of differentiated Auger peaks. The images were determined from the peak-to-peak intensities without application of relative sensitivity factors, however provided the appropriate data are available, proper atomic concentration images are possible and these images allow the surface to be viewed using the same regime normally adopted for spectra.

**Auger Image Analysis Steps in CasaXPS**

The essential sequence of steps required to process the image data is as follows:

1. Convert the image set to spectra at each pixel.
2. Differentiate all the spectra.
3. Define quantification regions for each transition and propagate these quantification regions to each VAMAS block containing a row of spectra.
4. Convert the region intensities to images.

Within these steps there are potentially sub-steps and these sub-steps are detailed below based on the original data for the given example.

The Auger images were acquired on a PHI Auger system, in this particular case, using two data files in which the saved images correspond to a sequence of unit energy steps over an interval spanning 370 eV to 331 eV. Since the data are in two separate files, the first job after the data are converted to VAMAS format is to assign the correct energy to the experimental variable for each image and then move the images into a new experiment frame.
Ordering the Images using the Experimental Variable

Initially, when converted through CasaXPS, the PHI .map files each contain half the images for the entire data set. The images are assigned the same experimental variable and the species/transition VAMAS block fields are all different, therefore the VAMAS blocks appear in the right-hand pane of the experiment frame as a single row.

To convert a set of images to spectra at each pixel, the images must appear in the same column and the experimental variable for each image assigned the value for the energy at which the image was acquired. To reorganize the data as required, the next step is to assign the species/transition fields for each VAMAS block in the file:

1. Select the entire set of VAMAS block in the Experiment Frame.

Since the data blocks appear in a single row in the right-hand pane, the entire set of blocks are selected by either left-clicking the mouse with the cursor over experimental variable value; or click once on the button heading the column for the experimental variable values. Both these actions will result in the full set of VAMAS blocks being selected. The former action relies on all the data appearing in a single row, whereas the latter selects the entire set of VAMAS blocks in the experiment frame.

2. Press the button on the second toolbar and enter new Element/Transition strings on the resulting dialog window. When the OK button is pressed, all the selected VAMAS blocks are assigned the pair of
strings entered on the dialog window and as a consequence, the right-hand-side of the Experiment Frame is reordered so that all the VAMAS blocks appear in a single column.

Once the VAMAS blocks appear as a single column in the right-hand pane of the experiment frame, the values for the experimental variable can be adjusted to the energy at which each image was acquired. The two toolbar buttons provide a means of assigning the experimental variable value on bulk; however the left-most of this pair of buttons offers a means of specifying a range of values for the experimental variable, where each row of VAMAS blocks will be assigned intermediate values. Thus, following rearrangement into a single column, the VAMAS blocks are assigned the appropriate experimental variable values by specifying the range 370 – 351 eV.
Similarly the second file can be adjusted into a column of VAMAS blocks by assigning the same element/transition strings to each VAMAS block used in the first file and reassigning the experimental variables for the images using the toolbar button to specify the range 350 – 331 eV. After making these assignments for the experimental values to both files, the two sets of VAMAS blocks can be merged into a new experiment frame.

**Copying VAMAS blocks between Experiment Frames**

Moving VAMAS blocks between experiment frames involves selecting in the right-hand panes all those blocks to be copied, transferring focus to the destination experiment frame before pressing the Copy/Paste VAMAS blocks toolbar button.

On pressing the toolbar button a dialog window listing all the selected VAMAS blocks provides a means of checking only the intended blocks are selected.
The OK button on the dialog window accepts the selection and results in copies of the selected blocks being merged into the experiment frame with focus.

Although the VAMAS blocks now appear in the same experiment frame all in one column and the map energy is assigned to the experimental variable, there is still one possible problem. The images are ordered from high kinetic energy to low and so the spectra, when generated, will be assumed to be XPS data rather than AES. It is also possible that the merged files appear back to front, from the energy scale perspective, and so the true order of the images, with respect to energy, may yet be realized. The functionality in the second button for assigning the experimental value is required to force the appropriate reordering. The dialog window invoked by the right of the two toolbar buttons allows the assignment of the experimental variable for a selected set of VAMAS blocks.

Further, once the assignment for the selection is made, the VAMAS blocks are reordered with respect to the new set of experimental variables. To cause a reordering of the image set, simply select a single VAMAS block and press the OK button on the dialog window. Although no new value was actually assigned, the reordering will still take place and the images then appear in the experiment frame ordered with respect to the map energies.
Converting Images to Differentiated Spectra

Given the set of images, now ordered with respect to energy, the analysis proceeds by converting the image data set into a set of spectra, one spectrum per image pixel. The conversion from images to spectra is achieved using the Image Processing property page on the Image Processing dialog window.

To invoke the Image Processing dialog window, click on the displayed image to ensure the Options menu items are active, and then select the Image Processing menu option. Overlay the images in the Active Tile and press the Convert Images to Spectra button on the Image Processing property page.
It is important that all the images are acquired using the same acquisition time and the experimental variable represents a sequence of evenly spaced energies. If the step in energy between the images deviates from a constant difference, then an error message will appear and no conversion to spectra takes place.

The converted spectra appear in a new experiment frame, where the experimental variable is labelled pixel and the values for the experimental variables represent row indices of the pixels in the original images.

Each VAMAS block contains an entire row of spectra; the spectra are stored as corresponding variables in each VAMAS block and as a result of the method used to store the spectra at pixels, a new processing option on the Differentiation property page of the Spectrum Processing dialog window
specifies that the operation should be applied to all the corresponding variables in a VAMAS block, rather than simply to the corresponding variable currently displayed in the active tile.

The data in all the VAMAS blocks must be differentiated. Therefore once the data in the active tile is differentiated, the propagate mechanism should be used to process all the VAMAS blocks similarly.

To propagate the differentiation, select the entire set of VAMAS blocks in the right-hand pane of the experiment frame and right-click the mouse button over the active tile containing the differentiated spectrum.
On the Browser Operations dialog window, tick the Processing tick-box within the Propagate section and press the OK button. All the spectra within the targeted VAMAS blocks will be differentiated.

Since the spectra generated from images are stored as multiple corresponding variables and only one corresponding variable from a given VAMAS block can be viewed at a time, it becomes necessary to step through the corresponding variables to inspect the results of the differentiation operation. To step through the corresponding variables in a VAMAS block, the Control + Page-Up and Control + Page-Down keyboard buttons are used. The corresponding variable index in each VAMAS block within an experiment frame is adjusted by the Control + Page-Up and Control + Page-Down keys. Similarly, Control +
Home and Control + End move the corresponding variable index to the beginning and end indices for each VAMAS block in the experiment frame. To adjust the index for a corresponding variable on a VAMAS block by VAMAS block basis, using the Page-Up, Page-Down, Home and End keyboard keys whilst holding down the Shift key causes only the VAMAS blocks in the active tile to be adjusted.

**Quantifying the Spectra at Pixels to Produce Images**

The quantification of Auger spectra is typically performed using the peak-to-peak metric to measure line intensity. In this example, two Auger lines are evident in the energy range 331 – 370 eV and so two quantification regions can be defined on each spectrum as indicated by the grey bands over the data.

These quantification regions are defined on the Quantification Parameters dialog window via the Regions property page. The regions for use with the spectra-to-images options are identical to those used for general spectral quantification, but with one slight difference. The default action of the **Convert Regions to Images** button on the Image Processing property page is to create images using the integrated intensity based on peak area. For differentiated AES data, the peak-to-peak intensity is required; therefore to create images appropriate for the differentiated data, the Tag field in the region specification table must be assigned a keyword string, namely, *peak to peak*. 
The Tag field is also used to switch between other parameters determined from regions such as fwhm, position and centroid; using these various region outputs, the surface mapped by the images can be viewed with respect to peak broadening or peak shifts. Again the Tag field is entered with the appropriate keyword string e.g. \textit{fwhm}, \textit{position} or \textit{centroid}.

Once quantification regions have been propagated to each VAMAS block in the spectrum file, the corresponding images are generated by overlaying all the spectra from the VAMAS blocks in the active tile and pressing the Convert Regions to Images button on the Image Processing property page.
Ideally, images for each element identifiable on the sample surface should be measures and a similar analysis to the Ag and Au data performed for each element. In this example only two elemental images were recorded, but nevertheless, proceeding to the quantification step based on the two available images has merit in that the resulting images are normalized with respect to each other across the field of view.

The button labelled Quantify Images can be used to perform the operation. The calculation assumes the images are generated from either quantification regions or synthetic components, both of which are in units of CPSeV (for area based intensities) or CPS (for peak-to-peak measurements), therefore the new images are generated simply using the formula $I_j / (I_0 + I_1 + \ldots + I_n)$. Intensity adjustments for relative sensitivity are accommodated by entering an appropriate value in the RSF field in the quantification regions or components. To perform the quantification step, overlay all the images in the active tile, then press the Quantify Images button. A new experiment frame is created containing the quantified images.
Note, a second button labelled Quantify Peak – BG offers a second means of quantifying a set of images. The procedure in this case does not involve images pre-processed using spectral regions or components and therefore adjustments for time will be included in the calculation. This is neither appropriate nor desirable for data processed as described in this section, but is available for use with raw images, where a less sophisticated approach is adopted.

**RBD Instruments Inc. Auger Scan**

PHI Auger instruments upgraded by RBD Instruments Inc export data in ASCII files or via the clipboard into CasaXPS. The following are a set of case studies based on data acquired using RBD Auger Scan software.

Auger Scan ASCII files include formats suitable for a single survey spectrum, the equivalent of a PHI multiplex acquisition consisting of one or more high resolution spectra or depth profiles relating multiple acquisition cycles to an experimental variable. The data may be acquired in direct $EN(E)$ mode or as differentiated spectra.

**Survey Spectra**

Direct spectra acquired in $EN(E)$ mode provide an opportunity to visualize the data in the form as acquired:
or numerically differentiated:

Data acquired in differentiated mode differs in the sense that the baseline to the data does not necessarily approximate zero.
The original form for these data files:

are essentially the same. Since modern instruments typically acquire the Auger spectra in direct mode, the data are assumed to be recorded in direct mode. The implications for the VAMAS file created from these ASCII files are that the VAMAS fields entered by default may need adjusting for the specific data type. The most notable information requiring adjustment is the electron gun energy and the VAMAS technique fields. Both fields influence the ease with which data are quantified.
The VAMAS block technique field is assigned by default the value AES dir; data acquired as differentiated signal should be assigned the technique AES diff. CasaXPS uses the technique field to determine the type of annotation information placed over the display when the Region property page on the Annotation dialog window is applied. For data known to be differentiated, the Region property page creates a table in which peak-to-peak height intensity is reported and used to calculate the atomic concentration. If the data cannot be identified as differentiated, the table offers peak area results.

An annotation table created from differentiated data either acquired in that form or externally processed prior to importation into CasaXPS must be assigned a technique type of AES diff.
Direct data differentiated within CasaXPS automatically displays the annotation table in terms of peak-to-peak height and peak-to-peak atomic concentrations. The combination of data assigned the technique AES dir and the presence of a processing instruction for differentiating the data displayed via the Processing History property page on the Spectrum Processing dialog window trigger the display of peak-to-peak annotation table.

Note: spectra differentiated in CasaXPS, but copied to a new VAMAS block using the Processed Data Only option will no longer include any processing history and therefore the technique in the copied VAMAS block should be assigned a value of AES diff.
Quantification of spectra involves the correct assignment of an RSF to a transition. RSFs are stored in the element library and to access the appropriate set of transitions for a particular piece of data also requires the correct assignment of the electron gun energy in the VAMAS block containing the data. By default the electron gun energy is assigned a value of 3000 eV. Many older instruments do not have computer control of the electron gun and therefore user intervention is required to specify the actual electron gun energy for the data. The electron gun energy determines the table of RSFs offered via the element library corresponding to the data displayed in the active tile. Quantification regions created via the Element Table property page of the Element Library dialog have RSFs entered into the RSF field based on the table of library entries visible on the property page. It is therefore essential that the correct electron gun energy is assigned prior to the creation of regions.
A VAMAS block with Source Energy set to 3000 eV and Source Label set to electron gun results in the Element Table being populated with those library transitions with Excitation Source string S(3). Similarly, a Source Energy of 5000 eV matches to library entries with Excitation Source string S(5).

**Multiplex Auger Spectra**

An Auger Scan file may contain more than one spectrum. These spectra typically represent narrow scan data measured for energy intervals in which Auger peaks are expected.

When converted to VAMAS format, each of the narrow scan spectra appear as separate VAMAS blocks.
Note that these narrow scan spectra, for example, have been exported from Auger Scan as processed data, where the processing step was that of numerical differentiation. Data processed externally to CasaXPS are still converted to VAMAS with technique AES dir and so, to be correct, the technique field must be manually adjusted to AES diff. For narrow scan data, the need to set the technique is less important than for survey spectra as quantification of multiple spectra is typically performed using the Report Spec page of the Quantification Parameters dialog window where the nature of the report is specified via configuration files.

In general data exported from Auger Scan may be raw direct spectra, raw differentiated spectra or processed spectra.

**Depth Profile Data**

Auger depth profile data are exported from Auger Scan using a distinct format from data exported as multiplex spectra.
These data are organised into a VAMAS file using the acquisition region labels and etch times. The resulting array of VAMAS blocks as viewed through the right-hand pane of the experiment frame provides the mechanism by which regions are propagated to data from identical transitions.

A sputter depth profile involves removing material with an ion-gun interleaved with acquisition cycles where spectra are recorded from each new surface uncovered by the etching process.
A consequence of etching the material is that the environment for each surface changes with etch time and therefore the nature of the data alters too. An interface between layers may cause a change in chemical state for a transition. For example SiO$_2$ on elemental Si can cause shifts in peak positions due to charging conditions changing as well as chemical shifts in the peak positions. Differences in the data over the course of a profile are accommodated in CasaXPS by allowing each VAMAS block to maintain region parameters specific to the spectrum in the VAMAS block.

Regions are created using the Regions property page of the Quantification parameters dialog window. The regions displayed on the Regions property page are the regions defined on the VAMAS block displayed in the active tile. If more than one spectrum is displayed overlaid in the active tile then the VAMAS block selected first using the right-hand pane is the active VAMAS block in the active tile. The Regions property page displays the regions defined
on the active VAMAS block in the active tile. Any alterations to region parameters only apply to the active VAMAS block in the active tile. It is therefore possible to create regions most appropriate for the individual spectra by displaying the spectra one at a time in the active tile and making adjustments appropriate to the spectrum. Typically, such adjustments are only necessary for a limited number of spectra and the majority of spectra require essentially the same region parameters. The propagate mechanism allows a region defined on a spectrum to be propagated to other spectra based on the selection in the right-hand pane.

For the depth profile under consideration, the oxygen Auger peak is measured from four different environments.

Regions for each of these four environments are specified by, in turn, overlaying the data in the active tile. Creating the first region for the set of VAMAS blocks displayed in the active tile, followed by propagating the region to VAMAS blocks containing similar data.

Since propagation of regions is dependent on the selection in the right-hand pane, options for making selections in the right-hand pane can help target subsets of VAMAS blocks. The display tiles can be used to collect spectra with similar requirements, thus aiding the selection and re-selection of VAMAS blocks in the right-hand pane. The following window illustrates a scenario where the four environments for the oxygen are displayed in four display tiles. No VAMAS blocks are currently selected in the right-hand pane.
Each display tile represents a subset of VAMAS blocks. If the Control keyboard key is held down and the cursor placed over one of the display tiles, on left clicking the mouse button the VAMAS blocks displayed in the tile over which the cursor resides are toggled into the current selection in the right-hand pane. Thus, the set of VAMAS blocks displayed in the top right-most display tile are reselected as follows:

The VAMAS blocks displayed in the tile over which the cursor is placed are added to the selection such that, if the blocks are already selected, the action deselects the selected blocks while blocks previously not selected become selected. Since the propagate operation transfers regions etc to selected VAMAS blocks, collecting data in display tiles aids the selection and therefore propagation process. Once the subset of VAMAS blocks has been returned to
the selection in the right-hand pane, adjusting the region parameters for the block in the active tile naturally leads to the propagation of the changes to the associated data. Right-clicking the mouse with the cursor over the active tile invokes the propagation dialog window, thus facilitating the transfer of changes to all the data displayed in the active tile.

Once regions have been defined for all the spectra in the profile, a plot of atomic concentration against etch time is created via the Report Spec property page.

The Custom Report section on the Report Spec property page offers a means of tabulating intensities and atomic concentrations as a function of etch time.
These tables in turn are converted to a VAMAS file or exported via the clipboard to spreadsheet software. The File menu available once the data are tabulated using the Height button on the Custom Report provides a means of generated the VAMAS file, while the copy toolbar button places a text form of the table on the clipboard. These operations are described in earlier sections of the Auger manual.

The following profile plot is an example of a depth profile created via the File menu available when the Custom Report results window is the experiment frame with focus.
Thanks to Tyne R. Johns of Sandia National Laboratories for her assistance in editing this manuscript.

Data used in the preparation of this text are kindly provided by:
Prof Bridget Rodgers (Vanderbilt University)
Tyne R. Johns (Sandia National Laboratories)

Data provided courtesy of Sandia National Laboratories. All rights in the data are reserved by the US Government. Neither the US Government nor Sandia Corporation makes any warranty, express or implied, or assumes any liability with respect to the use of these data, and publication of these data does not constitute express or implied endorsement of any kind.

RBD Instruments Inc.
IFOS, Kaiserslautern, Germany
Examples of XPS Spectra
To illustrate the potential of the XPS technique, a set of spectra are presented below. The data are from a wide range of XPS instrumentation, both old and modern instruments. Credit should be given to those providing these example spectra, namely,

- University of Manchester, UK
- University of Nottingham, UK
- Peking University, China
- Max Plank Institute Düsseldorf, Germany
- Umeå University, Sweden
- Lehigh University, USA
- And several unnamed contributors.
